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Chapter 1 Overview 

Welcome to RESULT Integration software. RESULT Integration is the 
development portion of the Thermo Scientific RESULT software for routine 
sample analysis. You can use RESULT to set up a controlled operating 
environment for the Thermo Scientific Antaris analyzers. 

Use RESULT Integration to create and test workflows, which contain 
software commands for collecting, measuring, reporting and archiving 
spectral data. Based on the overall task the workflow is to perform, you 
decide which commands you want to include and arrange them however 
you wish. Once the workflow has been completed, tested and saved, you 
can transfer the workflow to a production system where it can be 
systematically called up and run from RESULT Operation, which is the 
production application for RESULT.  

This manual describes RESULT Integration software and explains how 
RESULT Integration interacts with other applications, such as RESULT 
Operation, RESULT Data View, and Thermo Scientific TQ Analyst method 
development software. The major chapters in this manual are: 

• Getting Started. Read this chapter to learn how to start, quit and 
customize RESULT Integration and interact with the software’s main 
features.  

• Creating and Editing Workflows. This chapter describes how to use 
RESULT Integration software to create and edit workflows, test a 
workflow by running it in a simulated production mode, save a 
workflow, apply digital signatures to workflows and their associated 
files, add a sampling sequence to a workflow, create instruction files for 
workflows, and transfer a workflow to a production system for repeated 
use. 
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• Tools for Building Methods and Viewing Spectra. This chapter 
describes how to use the options in the Tools menu of RESULT 
Integration software and your TQ Analyst method development 
software to build an analytical method and assign the method to a 
workflow. The chapter also covers tools for collecting and viewing 
spectra using RESULT Integration software and information about using 
third-party method development applications with RESULT.  

• Troubleshooting Workflows in RESULT Integration Software. This 
chapter discusses errors that may occur when running workflows in 
RESULT Integration software and explains how to resolve the errors. 

Anyone who is responsible for setting up processes and instructions to run 
Thermo Scientific application-based analyzers should read this manual. To 
learn about the software commands that are available for use in workflows 
created in RESULT Integration software, see the manual titled “Workflow 
Events and Specifications.” If you want to learn about the production 
application for RESULT, called RESULT Operation, or the application for 
viewing sequence data files, called RESULT Data View, see the user guide 
with that name. If you want a quick overview of RESULT Integration, read 
Getting Started using RESULT and complete the steps in the software to 
develop and run a basic workflow.  
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Chapter 2 Getting Started 

This chapter demonstrates how to start, quit and customize RESULT 
Integration and explains how to interact with the software’s main features.  
 

Starting  
RESULT Integration 

Before you can log on to the computer workstation, you must receive a 
Windows user name and password from your Windows administrator.  

To start RESULT Integration software:  

 
1. Double-click the RESULT Integration shortcut on your workstation 

desktop. 

After you have successfully started RESULT Integration, the RESULT main 
window displays. 

 

RESULT Integration software main window 
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Setting RESULT 
Integration options 

You may customize the directory locations (paths) in RESULT Integration 
software. This allows you to quickly locate and store files in selected 
locations when creating and testing workflows. You can also select the 
instrument model that will be used to run your workflows and specify 
whether the system includes the ValPro System Qualification option. The 
selected instrument model defines the options available in RESULT 
Integration software for configuring instrument settings, such as sampling 
technique and instrument gain.  

The directory paths and other options you can specify are listed below: 

• Paths for archiving data. These options define the directory paths the 
software uses to archive spectral and report files created while setting up 
and testing workflows in RESULT Integration. Spectral data files of 
backgrounds, samples and standards may be archived using unique 
directory paths.  

• Paths for locating workflows and methods and HTML image files. 
These options define the default directory paths the software uses for 
locating workflow and method files and image files when those files are 
accessed through RESULT Integration software.  

• Target Instrument. These options specify the instrument model for 
your workflows and whether the system includes the optional ValPro 
System Qualification package. The selected instrument model defines 
the options available in RESULT Integration software for configuring 
data collection and other instrument settings.  

 Note These are the same types of options that can be specified in RESULT 
Operation software. Directory paths and other options that are specified in 
RESULT Integration do not affect those settings in RESULT Operation when 
workflows are transferred between the two applications.  

To configure RESULT options: 

1. Choose Options from the Edit menu in the RESULT Integration 
main window. 



 

Thermo Scientific RESULT Integration Software User Guide 5 

The Options dialog box is displayed, as shown below. 

  
 

2. Specify each path for archiving data by choosing the associated 
Browse button and then locating and selecting an appropriate 
directory. 

The first text box in this group specifies the base path for archiving 
sample spectra and report files created while testing workflows in 
RESULT Integration. You may create and select subfolders for archiving 
this data when setting up a workflow but you cannot select folders that 
are above the directory path specified here. See “Archive Events” in 
“Workflow Events and Specifications” for information about specifying 
subfolders for archiving sample spectra and reports.  

The next two text boxes specify the directory paths for archiving spectra 
of backgrounds and standards collected in RESULT Integration. You 
may select a unique directory path for each of these items or place them 
all in the same path.  
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 Note You may create and select subfolders for archiving standards when setting 
up a method but you cannot select folders that are above the directory path 
specified here. See “Configuring Standards” in “Chapter 4 Tools for 
Building Methods and Viewing Spectra” for more information. The path 
for archiving backgrounds can only be specified in the RESULT Options 
dialog box.   

3. Select a path for locating workflow and method files and HTML 
image files by choosing the associated Browse button and then 
locating and selecting an appropriate directory. 

These will be the default paths for opening and saving workflows and 
their associated TQ Analyst method files and image files in RESULT 
Integration software. When using RESULT Integration, you may browse 
to any directory to locate or save these items. For convenience, store 
these items in one directory and then specify the path in this dialog 
box.  

 Note Workflows and their associated TQ Analyst method files must be stored in 
the same directory.   

The original path for images points to the bitmap and other image files 
provided by the software, such as the pass ( ) and fail ( ) image 
files. These image files are available to users for placement in sample 
reports or other HTML documents created using RESULT Integration 
software. See “Report Item Specifications” in “Workflow Events And 
Specifications” for details on adding the pass or fail image to heading 
and table sections in a sample report.  

You can add your own image files to a sample report by placing the 
files in the image folder specified here and setting up a heading section 
that calls the image. See “Heading Item Specification” in “Workflow 
Events And Specifications” for details on adding other images to 
reports created using RESULT Integration software.  

If you reset the path for locating images, you must copy the images 
stored in the default image folder to the new image folder before those 
images can be used in subsequent reports. If you transfer a workflow 
that specifies one or more images in a sample report to RESULT 
Operation software, make sure you copy the image files along with the 
workflow. See “Transferring A Workflow To RESULT Operation” in 
“Chapter 2 Creating And Editing Workflows” for more information. 
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4. Specify the configuration of the instrument that will be used to run 
any workflows developed in RESULT Integration software by 
selecting the instrument model. 

 

• Model. Your selection in this list box will determine the options 
available in RESULT Integration software for configuring 
instrument settings. For example, if you want to develop workflows 
for an Antaris or Antaris II Method Development Sampling (MDS) 
system, set Model to “Antaris MDS System” to ensure that all of 
the available options appear in the software. If you are working 
with another Antaris system, such as the Fiber Optic System or the 
Antaris IGS, select the option in the Model drop-down list that 
matches your system name. If you have a configurable Antaris II 
system, set Model to “Antaris MDS System” to see all the options 
in the software or select an option that matches your instrument 
configuration. For example, if you have an Antaris II that is 
configured for fiber optic sampling, set Model to “Antaris Fiber 
Optic System” to limit the software to features that apply to fiber 
optic sampling. The following table describes the available options:  

Instrument Model Description 

Antaris II or Antaris MDS System Includes transmission module, 
integrating sphere and fiber optic 
sampling station.  

Antaris Liquid Analyzer System Configurable Antaris or Antaris II 
system that includes only the 
transmission module.  

Antaris Fiber Optic System Configurable Antaris or Antaris II 
system that includes only the fiber 
optic sampling station.  

Antaris Solid Sampling System Configurable Antaris or Antaris II 
system that includes only the 
integrating sphere.  

Antaris Tablet Analyzer System Configurable Antaris or Antaris II 
system that includes only the 
standard and/or softgel tablet 
analyzer.  
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Instrument Model Description 

Antaris RTS System Configurable Antaris or Antaris II 
system that includes the 
transmission module and integrating 
sphere.  

Antaris MX or EX System A compact fiber optic system with 2 
or 4 channels for connecting fiber 
optic accessories.  

Antaris Target Series System A compact, near-infrared analyzer 
dedicated to real-time monitoring of 
pharmaceutical powder blending. 
Installs directly on the bin and can 
also be used for desktop sampling. 

 
 
5. When you are finished configuring RESULT options, choose OK to 

save your changes and close the dialog box. 

The new settings will apply to any new workflows created in RESULT 
Integration software or run using the Test Workflow feature in RESULT 
Integration.  

 Note Directory paths and other options that are specified in RESULT Integration 
do not affect those settings in RESULT Operation when workflows are 
transferred between the two applications.  
 

Software basics Read this section to learn about the unique features of RESULT Integration 
and how to operate the software. The following features are introduced: 

• RESULT Integration main window 

• Menu bar 

• Toolbar 

• Workflow navigation frame 

• Workflow tree 

• Specification tree 

• Display area 
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You should understand how to use these features before attempting to 
create or edit workflows using RESULT Integration software.  
 

Main window 
components 

After you start RESULT Integration, the software’s main window is 
displayed on the screen, as shown below.  
 

 
 

You can change the 
relative sizes of the 

workflow navigation 
frame and the display area 
by dragging their common 

border right or left. 

 

RESULT Integration software main window 
 

You can maximize, minimize and resize the RESULT Integration window 
just as you can other application windows that run with Windows software. 
See your Microsoft Windows documentation for information on these 
standard Windows features. 

The RESULT Integration main window is divided into five parts: the title 
bar, the menu bar, the toolbar, the workflow navigation frame, and the 
display area. All of these features are described in the sections that follow. 
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Title bar The title bar appears at the top of the RESULT Integration main window. 
When you create or open a workflow, the workflow’s file name appears in 
the title bar. If no workflows are open, the default file name (Workflow1) 
appears in the title bar.  

If you open and then change a workflow that has been previously saved on 
a disk, an asterisk appears after the workflow’s file name in the title bar, as 
shown below. 

 
 

Menu bar The menu bar appears below the title bar in the RESULT Integration main 
window and contains the menu names. The menus provide useful 
commands for working with workflow files and spectral data.  

You can choose commands in RESULT Integration menus just as in other 
Windows applications: by using the mouse or by typing key combinations 
on the keyboard. The key combinations are shown in the menus. See 
“Software Accessibility” for specific information on selecting menus and 
choosing commands using the keyboard.  

The following menus appear in the RESULT Integration menu bar: 

 

• File. Provides program and file management functions, such as 
creating, opening, saving, signing, and testing workflow files, and 
exiting the software. 

• Edit. Provides commands for adding elements to a workflow, either 
individually or by using the Workflow wizard, and commands for 
standard editing functions, such as cutting, copying and pasting items 
in a workflow.  

• Tools. Provides tools for building a TQ Analyst method, including 
configuring and collecting standards, and for collecting and viewing 
spectra using RESULT Integration software. 

• Help. Gives the version number for RESULT Integration software. 



 

Thermo Scientific RESULT Integration Software User Guide 11 

See “Chapter 2 Creating And Editing Workflows” for details on each menu 
command or look up the command name in the index at the end of this 
document. 
 

Toolbar The toolbar appears below the menu bar at the top of the RESULT 
Integration main window. It provides a convenient way to initiate 
frequently used menu commands and other functions in a single step.  

 

You can use the toolbar to perform the following operations with the open 
workflow: 

 
New. Use the New tool to create a new workflow.  

 
Open. The Open tool allows you to open an existing workflow that was 
saved on a computer disk or network location.  

 

Save. Use Save As to save the open workflow. If the workflow was not 
previously saved, you must enter a file name before saving.  

 
Test. The Test tool runs the open workflow so you can see how it will 
operate on a production system. The test feature of RESULT Integration 
mimics RESULT Operation, which is the production application for 
RESULT.  

 
Add. Use this tool to add software commands, called “events,” and 
parameter groups, called “specifications,” to the open workflow. The 
selected event is added after the current cursor location in the workflow 
tree. Added specifications are placed in the selected group in the 
specification tree.  

 
Wizard. Select this button to start the Workflow wizard. The wizard is a 
handy tool for quickly creating a functional workflow that contains the 
basic components to collect, measure, report, and archive spectral data, or 
for adding those components to a workflow.  
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Expand. Choose this tool to expand the workflow or specification tree that 
is currently displayed in the workflow navigation frame so that all of the 
items contained in the tree are visible.  

 
Collapse. This tool collapses the displayed workflow or specification tree so 
that only the first level structures are visible.  

 
Back. Use this tool to navigate between screens in the open workflow. The 
Back button returns to the previous screen. After you use the Back button, 
the Forward button becomes available in the software.  

 
Forward. Use this tool to navigate between screens in the open workflow. 
Use the Next button to return to the screen that was displayed the last time 
you pressed the Back button.  

 
Reset. After editing the parameter settings for a displayed workflow event 
or specification, you can use the Reset button to restore those parameters to 
the settings displayed when you first selected that workflow event or 
specification.  

To use a feature on the toolbar, use the mouse to choose the icon or hold 
down the Alt key on your keyboard while you type the underlined letter in 
the name that appears below the icon. To save the open workflow, for 
example, either choose the Save As icon or type Alt + S. 
 

Workflow  
navigation frame 

The workflow navigation frame appears at the left side of the RESULT 
Integration main window. You will use this frame to create, add to or 
simply display the contents of the open workflow.  
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What is a workflow? 
Workflows are the underlying concept behind RESULT software, which 
provides development and production tools for routine sample analysis. 
Each workflow may contain one or more software commands for 
collecting, measuring, reporting, or archiving spectral data. Based on the 
overall task the workflow is to perform, you decide which commands you 
want to include and arrange them however you wish. Once the workflow 
has been completed, tested and saved on a disk, you can transfer the 
workflow to a production system where it can be systematically called up 
and run. The software commands within a workflow will be carried out 
precisely as they appear in the workflow—with the same detail and in the 
same order.  

 
Workflow tree The workflow navigation frame is your palette for creating and editing a 

workflow. If you use the Workflow wizard to get started, the basic 
components of a functional workflow (collect, measure, report, and 
archive) are added automatically, as shown below.  

 

We call these commands “events” because they specify a task that will be 
carried out only when the workflow is run. You may add and delete events 
and arrange them in any order. The events may be linear or grouped. 
Grouped events can be performed, repeated, or performed based on the 
results of a conditional test.  

As you build a workflow, we call the basic structure a workflow tree 
because it looks and operates similar to a computer directory tree. To 
display or hide the events within a group, click the plus (+) or minus (-) 
sign to the left of the group name or double-click the group symbol ( ). 
For example, to see the events in the group called “Polystyrene” in the 
illustration below, click the plus sign to the left of the group name.  
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Collapsed workflow tree 

The group is expanded to show the workflow events it contains, as shown 
below. 

 

Expanded workflow tree 

 
To quickly expand the entire workflow to show all of the events within 
every group, choose the Expand button on the toolbar. 

 
Specification tree Most of the workflow events have one or more associated specifications, 

which define how the event will be performed. The collect event, for 
example, has an associated sample specification, which defines sample 
collection for a given sample type or material.  
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A collect event may have other associated specifications as well. For 
example, if you want to display a dialog box that tells the operator how or 
where to insert the sample, you will need to add an operator prompt 
specification, which defines the prompt text and the action for the 
operator’s response. 

To see the names of the specifications that are contained in the open 
workflow, select the Details tab in the workflow navigation frame, as 
shown below.  

 

Collapsed specification tree 

We call this the “specification tree.” Specifications are automatically placed 
in functional groups. You can add and delete specifications but you cannot 
add, delete or change the group names.  

To see the specifications within a group, click the plus (+) sign to the left of 
the group name or double-click the group symbol ( ). To show the 
sample specifications, for example, open the Sample Specifications group, 
as shown below.  

 

Expanded specifications group 
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To quickly expand the entire specification tree to show all of the 
specifications within every group, choose the Expand button on the 
toolbar. 

 
Display area The display area is at the right side of the RESULT Integration main 

window.  

 

If the workflow tree is displayed in the workflow navigation frame, 
the display area shows the general options for the selected event, 
including the names of any associated specifications. When the 
collect event is selected, for example, the general collection options 
appear in the display area along with the names of the specifications 
for sample collection and any sample and background operator 
prompts, as shown in the next illustration. 

 

Collect Polystyrene event 
 

To see the general options for another event, choose the event name in the 
workflow tree. The event name is highlighted in the workflow tree and the 
general options for that event appear in the display area. The general 
options for the measure event are shown below. 
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Measure Polystyrene event 
 

To see a specification that is linked to the selected event, choose the Details 
button next to the specification name. For example, to see the sample 
specification for polystyrene, select the collect event by choosing its name 
in the workflow navigation frame and then choose the Details button next 
to “Sample Specification: Polystyrene Sample,” as shown below 
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The selected specification appears in the display area, as shown below. 
 

 

Polystyrene sample specification 
 

To return to the previous screen, select the appropriate event in the 
workflow tree or click the Back button on the toolbar.  

 

You can use the workflow tree to view the general options or an associated 
specification for any event in the open workflow. 

If you want to access all of the specifications for the open workflow, switch 
to the specification tree by choosing the Details tab in the workflow 
navigation frame. 
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Collapsed specification tree 

To see the specifications within a group, click the plus (+) sign to the left of 
the group name or double-click the group symbol ( ).  

To show the sample specifications, for example, open the Sample 
Specifications group, as shown below. 

 

Expanded specifications group 

 
To quickly expand the entire specification tree to show all of the 
specifications within every group, choose the Expand button on the 
toolbar. 



 

20 RESULT Integration Software User Guide Thermo Scientific  

 

Expanded specification tree 

To see the options in a particular specification, choose its name in the 
specification tree. The specification name is highlighted in the specification 
tree and the details for that specification appear in the display area. The 
next illustration shows the sample specification for polystyrene. 
 

 

Sample specification for polystyrene 
 

This is the same specification displayed from the workflow tree earlier in 
this lesson (after selecting the Details button next to the Sample 
Specification list box, as shown below). 
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You can display specifications from the workflow tree or the specification 
tree. However, only specifications that have been assigned to a workflow 
event can be accessed from the workflow tree, while the specification tree 
allows you to see all of the specifications that exist in the open workflow. 

 Note You can use the specification tree to view the options for any specification 
in the open workflow. Options for workflow events may only be accessed 
from the workflow tree.  
 

Accessibility RESULT Integration software has standard accessibility features, including 
hot keys and the ability to change display colors. 

 
Hot keys Each software feature can be accessed either by choosing a toolbar button 

or selecting a menu command or other item with the mouse, or by pressing 
a hot key or other key combination on the keyboard.  

If a command or button has an associated hot key, the hot key is indicated 
by the underlined letter in the command name. Some examples are: 

• The hot keys for starting the workflow wizard is Alt + W, as indicated 
by the underlined letter below. 

 

• The hot keys to open the Edit menu and choose the Add command 
from the Edit menu are Alt + E, and then A, as shown below. 
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- or - 
 
You can also choose Alt + E to open the menu, use the up and down 
arrow keys on the keyboard to select the command, and then press the 
Enter key to implement the command. 
 
- or - 
 
You can press Alt + A to choose the Add command without opening 
the Edit menu. 

Use the Tab key to make the items in a window or dialog box active. As 
you “tab” through a window or dialog box, the features become highlighted 
or marked with a dotted rectangle (or both) as they become active. Once a 
feature is active, you can use the appropriate keys on the keyboard to 
interact with it. Some examples include: 

• To select an item in a list, tab to the list and then use the up or down 
arrow key to move to the item. 

• To turn a check box on or off, tab to the check box and then press the 
space bar. 

• To select an option from a group of option buttons, tab to the option 
and then press the space bar. 
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• To choose a command button (such as OK) after tabbing to it, press 
Enter. 
 

Shortcut menus Use the right mouse button to display a menu of commands that apply to a 
selected item. For example, if you place the mouse cursor over the display 
area in the Run Time Test window and then hold down the right mouse 
button, the following shortcut menu appears:  
 

 
 

Select an item in the menu to apply it to the selected window.  

See your Windows documentation for complete information about using 
the keyboard to perform these and other standard Windows operations. 
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Display colors Some of the display colors for RESULT can be modified by changing 
Windows system colors. See your Windows documentation or on-line help 
for information about changing display colors.  

 Note If you are unable to change these settings or you are required to change the 
settings each time you log on to the workstation, then you have been 
assigned a mandatory profile or you do not have the Windows right to 
permanently change these settings. See your Windows administrator for 
more information.  
 

Quitting 
RESULT Integration 

You should quit RESULT Integration software before shutting off your 
computer workstation.  

To quit RESULT Integration: 

1. Choose Exit from the RESULT Integration File menu. 

Depending on whether you changed anything in the workflow without 
resaving the workflow, the following message may appear.  

 
 

2. Choose Yes to save your changes before closing RESULT Integration. 

Choosing No closes RESULT Integration without saving the open 
workflow. Any change made to the workflow since the workflow was 
last saved will be lost. Choosing Cancel will keep RESULT Integration 
open.  

After closing RESULT Integration, you are returned to the workstation 
desktop and remain logged on to Windows. 
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Chapter 3 Creating and Editing 
Workflows 

This chapter describes how to use RESULT Integration software to create 
and edit workflows, test a workflow by running it in a simulated 
production mode, save a workflow, apply digital signatures to workflows 
and their associated files, create instruction files for workflows, and transfer 
a workflow to a production system for repeated use.  

Example workflows are provided with RESULT software to help you “get 
the feel” of RESULT Integration software before creating a workflow. The 
example workflows demonstrate a variety of operations, ranging from basic 
data collection using the various sampling modules to conditional 
executions and loops.  

Look for the example workflows in the default directory for locating 
workflows after you install RESULT Integration software (C:\RESULT 
DATA\WORKFLOWS). All of the example workflows include simulated 
spectra (spectra stored with the workflow) that are appropriate for the 
workflow’s intended purpose.  

To run an example workflow using simulated spectra, choose Open from 
the RESULT Integration File menu and select the example workflow you 
want to run. Then choose Test from the RESULT Integration toolbar to 
display the Run Time Test window. Select Use Simulated Data at the 
bottom of the Run Time Test window, and then choose Go. 

The workflow simulates data collection by showing you any prompts or 
status information that will appear when the workflow is run normally. 
However, all workflow events that normally operate on the collected 
spectrum will use the simulated spectrum stored with the workflow instead. 
See “Testing a workflow” in this section for information about running 
workflows in RESULT Integration. 
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The software also includes the on-line document, EXAMPLE 
DESCRIPTIONS.PDF, which describes each example workflow. The 
document is stored in the default directory for locating instructions 
(C:\RESULT DATA\INSTRUCTIONS) as defined in the Options dialog 
box in RESULT Operation software. If you have a current version of Adobe® 
Reader® software, you can display the document from Windows Explorer 
by double-clicking the document name. You can also display the document 
in RESULT Operation software by selecting Example Descriptions from the 
Instructions list box in the RESULT Operation main window. 
 

Starting a  
new workflow 

There are three ways to start a new workflow in RESULT Integration 
software. You can start a new workflow by:  

• Choosing the workflow wizard on the RESULT Integration toolbar.  

• Choosing the New Workflow command in the RESULT Integration File 
menu. 

• Using the Open Workflow command to open an existing workflow 
and then resaving the workflow with a different file name. 

All three of these methods are discussed in the sections that follow. 
 

Using the wizard to  
create or add to a 

workflow 

RESULT Integration offers a handy tool to help you create a functional 
workflow that contains the basic components to collect, measure, report, 
and save spectral data. You choose which components you want to include 
from a single dialog box. When you close the dialog box, the new workflow 
appears in the workflow navigation frame. The new workflow contains all 
the events you selected and their associated specifications.  

If you select all the options available from the workflow wizard, your 
workflow will contain the basic components to collect, measure, report, 
and archive spectral data, as shown below. 
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Example workflow created  
using the Workflow wizard 

We call these components “events” because they specify a task that will be 
carried out only when the workflow is run. The tasks these events will 
perform are described briefly below: 
 

Event Name Description 

Collect Collects an infrared sample spectrum. 

Measure Can be linked to a custom TQ Analyst or other 
compatible method and used to make quantitative, 
qualitative or spectral measurements of the sample 
spectrum. 

Report Creates an HTML report that contains the sample 
spectrum and a table for organizing measurement or 
other results. 

Archive Saves the sample spectrum and/or the sample report in 
the specified location for archiving spectra and reports 
using unique file names. 

 

You can also use the workflow wizard to add these basic components to an 
existing workflow. 

How to create or add to a workflow using the workflow wizard: 

 
1. Start the RESULT Integration application and then choose the 

Wizard button on the RESULT Integration toolbar or choose 
Workflow Wizard from the Edit menu. 
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The following dialog box is displayed.  

 
 

2. Select the Sample Material text box and type a descriptive name for 
the type of sample you want to analyze.  

This is typically a specific name for the material the workflow will 
analyze, such as “polystyrene” or “aspirin.”  

 
 

3. If you want the workflow to collect a spectrum of your sample 
material, select the Collect option. 

When the Collect check box is selected, the rest of the parameters in 
the Collect group become available, as shown below.  
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The parameters in the Collect group will define a data collect event for 
the workflow. 
 

4. Specify the type of sample you want to analyze and the sampling 
module that will be used by selecting an option in the Sample 
Specification drop-down list. 

One or more of the following selections should be available: 

• Transmission Sample. Select this option if you want to analyze a 
liquid or film sample using the transmission sampling module of an 
Antaris FT-NIR analyzer. 

• Integrating Sphere Sample. Select this option if you want to use 
the integrating sphere sampling module (or the integrating sphere 
portion of the tablet analyzer sampling module) of an Antaris FT-
NIR analyzer to analyze a powder or solid sample. 

• Tablet Sample. Select this option if you want to use the standard 
tablet module of an Antaris FT-NIR analyzer to run a transmission 
analysis of an opaque tablet sample. 

• SoftGel Tablet Sample. Select this option if you want to use the 
softgel tablet module of an Antaris FT-NIR analyzer to run a 
transmission analysis of a softgel or gelcap tablet. 

• Fiber Optic Sample. Select this option if you want to use the fiber 
optic module of an Antaris FT-NIR analyzer and attached probe to 
analyze a sample. 

• Gas Cell Sample. Select this option if you want to collect data 
from a gas sample using the Antaris IGS (Industrial Gas System). 
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• Blend Analyzer Sample. Select this option if you want to collect 
data from a sample using the Antaris Target Blend Analyzer. The 
analyzer can be mounted on a blender bin or placed on a desk top.  

• Validation Wheel Sample. Select this option if you want to collect 
data from a sample on the optional validation wheel. The 
validation wheel is installed only in Antaris and Antaris IGS 
systems that include the ValPro System Qualification package.  
 

5. Set the remaining collection parameters as desired using the table 
below as a general guide, or leave the default values displayed in the 
dialog box.  

For details on these and other options that define data collection, see 
“Collect events,” “Sample Specifications,” and “Background 
Specifications” in “Workflow Events and Specifications.”  

Collection Option Description 

Sample Prompt Defines an operator prompt that will appear before 
sample collection when the workflow is run. 

Background Prompt Defines an operator prompt that will appear before 
background collection when the workflow is run. 

Number Of Scans Defines the number of times the analyzer will scan the 
sample to produce a spectrum. 

Resolution Defines the resolution of the sample spectrum. 
Resolution is a measure of how well closely spaced 
peaks in a spectrum are differentiated. 

Data Format Defines the Y-axis unit that will be used to display or 
plot the sample spectrum in a sample report. 

 

6. If you need the workflow to measure or extract data from the 
spectrum, select the Measure option.  

When the Measure check box is selected, the rest of the parameters in 
the Measure group become available, as shown below. 
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The parameters in the Measure group define how the sample spectrum 
will be measured in the new workflow. 
 

7. Set the measurement parameters as desired or leave the default 
values displayed in the dialog box. 

Use the descriptions provided below as a guide. For details on these and 
other parameters that define spectral measurements, see “Measure 
events” in “Workflow Events and Specifications.” 

Measurement Option Description 

TQ Analyst Method Allows you to select a TQ Analyst method (*.qnt) file 
that will be associated with this measure event. If 
an appropriate method does not exist, select None 
Selected in the drop-down list. 

Measurement Type Shows the Analysis Type setting in the selected 
TQ Analyst method. If no method is selected (see 
above), use this list box to specify the Analysis Type 
setting for a new TQ Analyst method. 

Measurements Lists the items the currently selected TQ Analyst 
method is set up to measure. If no method is 
selected (see above), use this text box to type the 
component names, class names, spectral 
measurements, or other attributes the new method 
will measure. 

 

8. If you want the workflow to report the spectral data, select the 
Report option.  

When the Report option is selected, the rest of the parameters in the 
Report group become available, as shown below. 
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9. Choose the sections to include in the report (see the descriptions 
below) by selecting the appropriate check boxes.  

For details on these and other options available for creating reports, see 
“Report Events” in “Workflow Events and Specifications.” 

Report Option Description 

Heading Defines a generic heading or title for the entire report, 
or a heading section in a report. A heading can contain 
text, images, and pertinent information, such as the 
instrument model or the current date and time (or any 
combination of these). A heading item specification 
defines each heading section in a report. 

Spectrum Defines a section in the report that will contain the 
spectrum of the sample collected by the workflow. If 
you select this option, the software adds the collection 
result (spectrum) to the spectrum item specification 
automatically. The spectrum item specification defines 
the spectrum or spectra to include in this section of the 
report. 

Table Defines a table of data that will be included in the 
report. A table can contain measurement, statistical, or 
other data, a pass or fail result, or the pass ( ) or fail 
( ) image provided with the software. If you select 
this option, you must open the table item specification 
and add each measurement or other result to include in 
the table before running the workflow. See “Table Item 
Specifications” in “Workflow Events and 
Specifications” for more information. 

Print Report Specifies whether the report will be printed 
automatically after the workflow is run.  

 

10. If you want the workflow to archive the sample spectra and/or the 
report, select the Archive check box. 
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If you run the workflow in RESULT Integration software (using Test on 
the toolbar), the data will be archived using the base path for archiving 
spectra and reports as defined in the RESULT Options dialog box. See 
“Setting RESULT Integration Options” in “Chapter 1 Getting Started” 
for more information. Each spectral and report file is given a file name 
that includes a globally unique identifier (GUID). 

If you elect to archive the data, you may also specify whether a user 
name and password will be required to archive the data by selecting Use 
Digital Signatures. When digital signatures are required, the workflow 
prompts the operator for a valid Windows user name and password 
before archiving the data.  

 Note Requiring digital signatures for spectra collected from production 
workflows can help ensure the authenticity of the data collected.  
 

11. When you are finished selecting items for the workflow and setting 
their associated options, choose OK. 

The wizard creates a workflow using the settings you specified. The 
workflow is displayed in the workflow navigation frame as shown in the 
example below. 
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12. Choose the Save button on the toolbar. 

The Save As dialog box is displayed. 

 
 

13. Select a folder for saving the new workflow or create and then select 
a new folder. 
 

14. Enter a descriptive name for the new workflow in the File Name 
box and then choose Save. 

The extension “.WFL” is automatically added to the file name.  

After you choose Save, the file name for the new workflow appears in 
the title bar at the top of the RESULT Integration main window, as 
shown below. 

 

 
Select the Expand button on the RESULT Integration toolbar to expand the 
workflow. The workflow contains the basic components to collect, 
measure, report, and archive spectral data, as shown below. 
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Use the Add button on the toolbar or the Add command in the Edit menu 
to add more events and specifications to the workflow. See “Adding Events 
And Specifications To A Workflow” in the next section for more 
information. You can also use the workflow wizard to add another collect, 
measure, report, and archive set to your workflow.  

To run the workflow, use the Test button on the toolbar or choose Test 
Workflow from the File menu. See “Testing a workflow”  
 

Using New Workflow 
to create a workflow 

Use the New Workflow command to start a new workflow when you want 
to use the system’s default settings for the workflow events and their 
associated specifications. The New Workflow command clears the 
workflow navigation frame of workflow events and specifications. Events 
and specifications may be added to the workflow one item at a time or you 
may use the workflow wizard to add the basic components of a functional 
workflow (collect, measure, report and archive) in a single step.  

To start a new workflow using the New Workflow command: 

1. Start the RESULT Integration application and then choose New 
Workflow from the File menu. 
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If the following message appears, choose Yes to save the open workflow 
before closing it.  

 

RESULT assigns the new workflow a default file name (Workflow1), 
which appears in the program’s title bar, as shown below.  

 
 

 
2. Choose the Save button on the toolbar. 

The Save As dialog box is displayed. 

 

Select a folder for storing the new workflow or create and then select a 
new folder. 
 

3. Enter a descriptive name for the new workflow in the File Name 
box and then choose Save. 

The extension “.WFL” is automatically added to the file name.  
 



 

Thermo Scientific RESULT Integration Software User Guide 37 

After you choose Save, the file name for the new workflow appears in the 
title bar at the top of the RESULT Integration main window, as shown 
below. 

 

The workflow, displayed in the workflow navigation frame, consists of a 
single workflow group that contains no other items.  

 

All of the groups in the specification tree are also empty. 

 

Use the Add button on the toolbar or the Add command in the Edit menu 
to add events and specifications to the workflow. See “Adding events and 
specifications to a workflow” in the next section for more information.  

You can also use the workflow wizard to add the basic components of a 
functional workflow (collect, measure, report and archive) in a single step. 
See “Using The Workflow Wizard To Create Or Add To A Workflow” in 
the previous section for more information. 
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Using Open Workflow 
to create a workflow 

Use the Open Workflow command to start a new workflow that will be 
similar to a workflow that already exists. Events and specifications may be 
added to the workflow one item at a time or you may use the workflow 
wizard to add the basic components of a functional workflow (collect, 
measure, report and archive) in a single step.  

To create a workflow using the Open Workflow command: 

1. Start the RESULT Integration application and then choose Open 
Workflow from the File menu. 

If the following message appears, choose Yes to save the open workflow 
before closing it.  

 

The Open dialog box is displayed listing the files in the default location 
for storing workflows. 

 

See “Setting RESULT Integration Options” in “Chapter 1 Getting 
Started” for information about setting this and other directory paths in 
RESULT Integration software. 
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2. Select the workflow file and then choose Open.  

You may need to change directories or disks to locate the file you want 
to open. When you choose Open, the software displays the contents of 
the selected workflow in the workflow navigation frame, as shown 
below. 

 
 

 
3. Select the Save button on the toolbar. 

The Save As dialog box is displayed. 

 
 

4. Select a folder for storing the new workflow or create and then 
select a new folder. 
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5. Enter a descriptive name for the new workflow in the File Name 
box and then choose Save. 

The extension “.WFL” is automatically added to the file name.  
 

After you choose Save, the file name for the new workflow appears in the 
title bar at the top of the RESULT Integration main window, as shown 
below. 

 

Use the Add button on the toolbar or the Add command in the Edit menu 
to add events and specifications to the workflow. See “Adding Events And 
Specifications To A Workflow” in the next section for more information.  

You can also use the workflow wizard to add the basic components of a 
functional workflow (collect, measure, report and archive) in a single step. 
See “Using The Workflow Wizard To Create Or Add To A Workflow” in 
the previous section for more information. 
 

Adding events and 
specifications to a 

workflow 

A functional workflow is comprised of workflow events and their associated 
specifications. Workflow events specify a task that will be carried out when 
the workflow is run. The software implements the tasks in the order in 
which they appear in the workflow navigation frame when you display the 
workflow in RESULT Integration software.  

Workflow specifications define how certain tasks will be carried out. The 
collect event, for example, has an associated sample and background 
specification, which define sample and background collection for a given 
sample type or material. 

There are two ways to add events and specifications to a workflow. You can 
use the Add button on the RESULT Integration toolbar to add a specific 
event or specification, or you can use the workflow wizard to add the basic 
components of a functional workflow (collect, measure, report, and archive 
events and their associated specifications) in a single step.  

This section describes how to add events and specifications using the Add 
button on the RESULT Integration toolbar. See “Using the workflow wizard 
to create or add to a workflow” in the previous section to learn how to use 
the workflow wizard to add events and specifications to a workflow.  
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Adding events  
to workflows 

When a workflow is displayed in the workflow navigation frame, you can 
use the Add command in the Edit menu or the Add button on the toolbar 
to add events to the workflow. The new event is added immediately below 
the selected event in the open workflow.  

To add an event to a workflow: 

1. Create or open a workflow and make sure the Workflow tab is 
selected in the workflow navigation frame. 

 
 

 
2. Choose the Add button on the toolbar or choose Add from the Edit 

menu. 

A list of available events is displayed, as shown below.  
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Notice that events are named with action words, such as “store” and 
“repeat.” The Description column explains the task the event will 
perform when you run the workflow.  
 
Simple events, which carry out a specific task, are marked with a red 
rectangle. Structural events are marked with a blue circle. They allow 
you to group events in order to control how they will be implemented 
in the workflow.  
 

3. Select an event so that its name is highlighted in the list of available 
events. 
 

4. Select the Base Name For This Event text box and enter a 
descriptive name for the new event.  

The name you enter will be appended to the event name. For example, 
if you select the Measure event and then enter the name “Polystyrene,” 
then the event will be named “Measure Polystyrene.” The software 
demonstrates how workflow events are named by showing the full 
name as you type. Here is an example:  
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 Note You must enter a base name before continuing. If you don’t, the software 
displays an error message. 
 

 
 
Choose OK to close the message and then enter a base name in the Add 
dialog box.  
 

5. When you are finished, choose OK to close the dialog box. 

The new event is added immediately below the selected event in the 
open workflow. Here is an example showing a simple measure event 
added to a workflow:  

 

Simple workflow events are marked with a red rectangle. Structural 
events have a blue circle because they create an event group. See 
“Chapter 1 Simple Workflow Events” and “Chapter 2 Structural 
Workflow Events” in “Workflow Events and Specifications” for more 
information. 
 

Adding specifications  
to workflows 

You may add a specification to a workflow from both the Workflow tab 
and the Details tab in the workflow navigation frame.  

 

Workflow tab, Details tab 
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When you add a specification from the Workflow tab, the specification is 
automatically linked to the selected event. A workflow specification that is 
added from the Details tab is available for use in the workflow, but it will 
not be used by the workflow until the specification is linked to at least one 
workflow event. 

This section describes both methods for adding specifications to workflows. 
It also explains how to link a new or existing specification to a workflow 
event.  
 

Adding a linked specification If a workflow event requires a specification, use the New button next to the 
specification list box to create a new specification for that event. 
Specifications that are created this way are automatically linked to the 
workflow event.  

To add a specification that is linked to a workflow event: 

1. Create or open a workflow and make sure the Workflow tab is 
selected in the workflow navigation frame. 

 
 

2. Select the event that requires a specification in the workflow 
navigation frame. 
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Here is a collect event that requires a sample specification:  

 
 

3. Click the New button to the right of the specification list box.  

 

Depending on the specification type, a dialog box may appear showing 
the available options. Here are some of the sample specifications for the 
Antaris II systems:  
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4. If a dialog box appeared in the previous step, select an appropriate 
specification for the current task, enter a base name for the new 
specification and then choose OK. 
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Here we’ve selected a transmission sample specification and entered the 
base name “Glass Sample.”  

If only one specification is available for the 
selected event, the software adds the 

appropriate specification automatically and 
gives it a default base name.  

 

After you choose OK, the new specification appears in the display area. 
Here is the transmission sample specification:  

 

The name “Glass Sample” appears in the text box at the top of the 
display area as shown in the above illustration. The default settings will 
be selected for all of the specification options. See “Workflow Events 
and Specifications” for information about customizing these settings for 
a particular sample. 
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5. Choose the Back button on the toolbar to return to the event.  

The specification name will appear in the list box. Here is the collect 
event with the sample specification named “Glass Sample” selected: 

 

Use the Details button next to the sample specification list box to display 
the sample specification named “Glass Sample.” When the sample 
specification is displayed, use the Back button to return to the collect event.  
 

Linking a specification  
to a workflow event 

If your workflow already contains specifications that are appropriate for 
your task, use the specification drop down list box to select a specification. 
Here is an example showing several options for a Before Sample operator 
prompt for a collect event: 

 

When the correct specification is selected, use the Details button next to 
the specification list box to show the selected specification in the display 
area. Here is the Before Sample prompt specification named “Sample 
Prompt (2)” shown in the display area: 
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When a specification is displayed, use the Back button to return to the 
associated event.  
 

Adding an unlinked specification  When the Details tab is selected in the workflow navigation frame, you can 
use the Add button on the toolbar or the Add command in the Edit menu 
to add specifications to the workflow. You might want to add specifications 
this way because the new specification is similar to an existing one. You can 
easily make a copy of the existing specification and customize it for the new 
application.  

When you add specifications from the Details tab, those specifications are 
not automatically linked to a workflow event. See “Linking a specification 
to a workflow event” in the previous section for instructions to link an 
existing specification to a workflow event. 

To add a specification to a workflow: 

1. Create or open a workflow. 
 

2. Select the Details tab in the workflow navigation frame. 

The specification tree appears in the workflow navigation frame, as 
shown below.  

 

The specification tree shows the types of specifications that can be 
added to a workflow. The specifications are grouped by function.  

    
Use the Expand and Collapse buttons on the toolbar to show or hide 
the specifications in all of the groups. 
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3. Select the specification group that corresponds with the type of 
specification you want to add to the workflow. 

To add a sample specification, for example, select the Sample 
Specifications group on the Details tab, as shown below:  

 
 

4. Choose Add from the Edit menu or choose the Add button on the 
toolbar.  

Depending on which specification group is selected, a dialog box may 
appear showing the specifications available in the selected group. Here 
is an example of the Add dialog box showing the available sample 
specifications:  
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5. If a dialog box appeared in step 4 above, select a specification and 
then choose OK to close the dialog box. 

The specification group is automatically expanded to show the name of 
the new specification. The options for the new specification appear in 
the display area. Here is the Transmission Sample Specification shown 
in the display area:  
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The new specification is given a generic name, which appears in the 
text box at the top of the display area. The default settings are selected 
for all of the specification options. See “Workflow Events and 
Specifications” for information about setting the options for a sample 
specification, or another specification in RESULT Integration. 

 Note The new specification is available for use only in the open workflow. 
However, it will not be used by the workflow until the specification is 
linked to at least one workflow event. See the next section to learn how to 
link workflow specifications to workflow events.  
 

Using a sampling 
sequence with a 

workflow 

RESULT workflows can be configured to require a sampling sequence to 
define the order, title and any other information required for a set of 
samples. This is useful for running an autosampler or for running a series of 
samples manually without requiring the operator to enter information 
about each sample at run time.  

The sampling sequence must specify a sample name and identification (ID) 
number, or position number if using an autosampler, for each sample. The 
sampling sequence can include other information in text or numeric format 
as needed. 

The workflow can specify that the sampling information must be entered 
manually or imported from a text file with or without operator input. You 
can create a sampling sequence and save it in the workflow, or create or 
specify a sampling sequence text file. The workflow controls whether the 
operator can view, select, create or edit the sampling sequence at run time.  
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To set up a workflow to use a sampling sequence: 

1. Add a repeat event to the workflow. 
 

2. In the repeat event, set Number of Repetitions to Use Sampling 
Sequence, as shown below. 

 
 

3. Specify the following options for defining the sampling sequence.  

• Use Sequence From Text File. Use this checkbox to specify a 
location for storing the sampling sequence.  

To use a sampling sequence stored in a text file on the computer 
disk, select Use Sequence From Text File. When you select this 
option, the File Name box becomes available in the software. Use 
the File Name box to enter a valid file name for the sampling 
sequence (must have a *.txt file name extension), or choose Browse 
and then select an appropriate sequence file. The base path is the 
default path for storing workflows in RESULT Integration software. 
If the specified file does not exist or contains an error, the workflow 
will prompt the operator to enter a sampling sequence or select a 
sequence file at run time. Using a text file to store the sampling 
information allows you to create the file at another computer and 
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easily copy and reuse the sequence in multiple workflows, or 
quickly switch the sampling sequence in the current workflow.  

To store the sampling sequence in the workflow, clear Use 
Sequence From Text File. You must use the Sampling Sequence 
group in the Repeat event to create the sampling sequence (see 
“Creating a sampling sequence” in the next section for details. The 
sampling information will appear and be saved in the workflow.  

• Require Operator Confirmation. Use this check box to specify 
whether the operator can view and edit the sampling sequence at 
run time or select another text file that contains the correct 
sampling sequence.  
 

4. If you are using an autosampler, add a position autosampler event 
to the repeat loop and set Autosampler Position to Next Position In 
Sampling Sequence.  

 

When you run the workflow, if the repeat event is set up to use a 
sampling sequence with operator interaction (i.e., Require Operator 
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Confirmation is selected), the first pass through the repeat loop will 
display the following dialog box: 

 

If Use Sequence From Text File is cleared, the dialog box contains the 
sampling information saved with the workflow. If Use Sequence From 
Text File is selected, the dialog box contains the sampling information 
in the specified text file.  

If the sequence displayed in the dialog box is correct, the operator 
simply chooses OK and the workflow continues. If the displayed 
sequence is incorrect, the operator can either edit the displayed 
information or create or import a new sampling sequence (see the next 
section). When the operator is satisfied with the sampling sequence, he 
or she chooses OK and the workflow continues.  

At a minimum, the sampling sequence should specify a sample name 
and ID, or position number if using an autosampler, for each sample. 
The workflow will implement the events in the repeat loop once for 
each line in the sampling sequence. See “Creating a sampling sequence” 
and “Importing a sampling sequence” in the sections that follow for 
more information. 
 

Creating a  
sampling sequence 

Read this section to learn how to create and save a sampling sequence with 
a workflow. The workflow must contain a repeat event that is set up to use 
a sampling sequence (see the previous section).  

Follow the instructions below to use the Repeat event to create a sampling 
sequence. If you want to learn how to import a sampling sequence to a 
workflow, skip to the next section. 
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To create and save a sampling sequence in a workflow: 

1. Display the Repeat event that will be used to initiate the sampling 
sequence. 
 

2. Add a row to the table and enter a sequence number for the 
corresponding sample.  

 

To add a row, right click any row in the table to display a shortcut 
menu. Then choose Add Row. The software automatically assigns the 
new row the next available ID number (or Position number, if using an 
autosampler). You can edit the ID or Position number by double-
clicking the field. Only integer values are accepted.  
 
You can enter the position and ID numbers in any order. However, 
each row must contain an entry for this field. The ID or Position 
number will be saved along with the spectral data at run time.  

If using an autosampler, the carousels typically start with position 0. 
However, depending on the workflow, position 0 may be reserved for 
background collections (see “Autosampler specifications” in your 
autosampler user’s guide for more information). If the workflow is 
configured to reserve position 0 for background collections, your first 
sample is probably located in position 1 or greater.  

 Notice If you are defining a sampling sequence for an autosampler, make sure the 
position number you enter in this dialog box matches the location of this 
sample in the autosampler carousel.  
 

3. Enter a title for the sample in the Title text box.  

To enter a title for a sample, double click the Title field for the 
corresponding sample ID number (or position number if using an 
autosampler).  

Each row must contain an entry for this field. The titles will be saved 
along with the spectral data at run time.  

 Note The title is a descriptive name saved within a spectral file; it is not the file 
name.  
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4. If you have additional information you want to include for each 
sample such as a special code or comment, add a customized 
column to the table and enter the corresponding information in the 
specified format.  

Information you add to a sampling sequence can be used in other 
places in the workflow such as a Report event or Report To Spectrum 
event.  

 

To add a column, right click a row in the table to display a shortcut 
menu. Then choose Add Column. The software displays the following 
dialog box.  
 

 

The following options are available: 

• Title. Enter a descriptive heading for the information you want to 
add to the table. You cannot leave the Title field blank. When you 
close the dialog box, the title will appear as the heading for the new 
column in the sampling sequence table.  
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• Apply Default Setting. Select this check box if you want to apply a 
default value or setting for all the cells in the column. Then enter 
the default value or setting in the corresponding entry box. For 
example, you can set the initial value for integer or floating point 
cells to 0 or the initial setting for a Boolean toggle to “No.”  

• Data Type. Use these radio buttons to indicate the type of data you 
want to enter for the fields in this column of the table. Text refers 
to a text string. The string can include any combination of letters, 
numbers, and other characters available from the computer 
keyboard or other input device. The Integer setting allows only 
positive whole numbers. If you want to enter fractions, use the 
Floating Point setting and then enter the number of digits you 
want to include to the right of the decimal point. Use the Boolean 
setting to define cells that toggle between Yes and No.  

• Format. Use these radio buttons to specify a format for the column 
cells. The Edit Box setting defines an editable field. The Combo 
Box setting defines a drop-down list box.  

Use the Item List entry box to specify the items in the drop-down 
list for the combo box and separate your entries with a semi-colon 
character. For example, to define a drop-down list box with three 
items in the list (e.g., Yes, No, and Maybe), the Item List should 
look like this: 

 

You can edit these settings at any time by double clicking a field in 
the custom column. The custom column fields are optional. The 
information in a custom field will be available for use by other 
events in the workflow such as a Report event, Report To Spectrum 
event, or Report To Text event.  
 

5. Repeat steps 2 through 4 for each sample in the sequence.  

The number of entries in your sampling sequence should match the 
number of samples you want to analyze.  
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The following additional options are available for editing the 
information displayed in the table. 

• To delete a row from the table, select the row, right click to display 
a shortcut menu and choose Delete Selected Row or press Delete 
on the keyboard. To delete several rows at once, hold down the 
Shift key while you click sequential rows (or the Control key for 
split rows) and then choose Delete. To delete a column, select the 
column, right click and choose Delete Selected Column or press 
Delete on the keyboard. 

• To change the order of the entries in your sampling sequence, click 
a row in the table and drag it to the new location. To move several 
rows at once, hold down the Shift key while you click sequential 
rows (or the Control key for split rows) and then drag the selected 
rows to the new location. 

• You can sort numeric and alphabetic data displayed in the table in 
ascending or descending order. To sort the table based on a specific 
column, select the column, right click to display a shortcut menu 
and choose Sort Descending or Sort Ascending.  

• You can export the sampling information displayed in the table to a 
text file. This can be helpful if you have a specific format you like 
to use for sampling sequences. You can then import a pre-
formatted sampling sequence when creating workflows for other 
experiments. See “Exporting a Sampling Sequence” in the next 
section for details.  
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6. Save the sampling sequence with the workflow. 

To save the new sampling sequence in the workflow, choose Save from 
the File menu in RESULT Integration software.  

 
Importing a  

sampling sequence 
Read this section to learn how to create a text file that contains a sampling 
sequence you can import to a RESULT workflow, and how to import the 
sampling information from your text file.  

 
Creating a text file that  

contains a sampling sequence 
This section explains how to use a text editor application to create a 
sampling sequence you can use with RESULT software. This gives you the 
option to create the sampling sequence on any computer and easily import 
the sequence to a RESULT workflow.  

You can also create a sampling sequence in RESULT software and save or 
export the sampling information to a text file. See “Creating a sampling 
sequence” in the previous section and “Exporting a sampling sequence” in 
the next section for more information. 

Text files can be created in any word processing, spreadsheet, or text editor 
application such as Microsoft® Word, Microsoft Excel® or NotePad. Make 
sure you use tabs rather than spaces to separate the columns and save the 
file using the *.txt file name extension. (If you use Excel, export the file as 
tab-delimited text and it will add the tabs for you.)  

The text file must contain at least two columns separated by tabs. The first 
column should contain the sample identification (ID) number or carousel 
position number if you plan to use an autosampler. The second column 
should contain the corresponding sample name. Additional columns of 
data can be included.  

Additional information and an example text file are provided below.  

• Sample ID or Position Number. The sample ID can be a number, 
letter or any other character representing sample index numbers, 
sequence numbers, bar code numbers, etc. and they can be in any 
order.  

• If you are using an autosampler, the position number is required and 
must be an integer. Thermo Scientific carousels typically start with 
position 0. However, depending on the workflow, position 0 may be 
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reserved for background collections (see “Autosampler specifications” 
in your autosampler user’s guide for more information). If the 
workflow is configured to reserve position 0 for background collections, 
your first sample is probably located in position 1 or greater. 

 Notice If you are defining a sampling sequence for an autosampler, make sure the 
position numbers you enter in the text file match the locations of the 
samples in the autosampler carousels.  

• Sample Title. The second column should contain a descriptive title for 
each sample. The titles are saved along with the spectral data.  

The following text file could be used to import a sampling sequence for 
manual operation:  

 001681 {tab} Sample a 
 001749 {tab} Sample f 
 001853 {tab} Sample i 
 001992 {tab} Sample l 
 002501 {tab} Sample o 
 003695 {tab} Sample x 
 

This one could be used for an autosampler:  

 1 {tab} Sample a Rep1 
 1 {tab} Sample a Rep2 
 2 {tab} Sample b Rep1 
 2 {tab} Sample b Rep2 
 3 {tab} Sample c Rep1 
 6 {tab} Sample d Rep1 
 8 {tab} Sample h Rep1 
 10 {tab} Sample j Rep1 
 

Importing a sampling  
sequence from a text file 

Follow the steps below to import a sampling sequence from a tab-separated 
text file. For information about creating the text file, see the previous 
section.  

Before you can import a sampling sequence to a workflow, you must add a 
Repeat event to the workflow, set Number of Repetitions to Use Sampling 
Sequence, and select Use Sequence From Text File.  



 

62 RESULT Integration Software User Guide Thermo Scientific  

To import a sampling sequence from a text file: 

1. In the Repeat event Sampling Sequence group, select Use Sequence 
From Test File and then choose Browse.  

 

The Open dialog box is displayed. 
 

2. Locate the folder and file you want to import.  

You can only import text files (*.txt file name extension). Text files can 
be created in any word processing, spreadsheet or text editor 
application such as Microsoft Word, Microsoft Excel or NotePad. The 
file must be formatted with tab-separated text like the examples shown 
in the previous section. 
 

3. Choose Open. 

The file name appears at the top of the Sampling Sequence group and 
the sampling information contained in the file appears in the table 
below the file name. 
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You can edit the sampling sequence you just opened and easily resave it. 
Use the features below: 

• Add/delete row. Select any row in the table and then right click to 
display a shortcut menu that contains options to add and delete rows in 
and add columns to the table. See “Creating a sampling sequence” 
above for information about the Add/Edit Column dialog box. 

• Edit/delete column. Select any column in the table and then right 
click to display a shortcut menu that contains options to edit, delete 
and sort columns in the table. You can sort numeric and alphabetic 
data in ascending or descending order. See “Creating a sampling 
sequence” for information about the Add/Edit Column dialog box.  

• Move Row. To change the order of the entries in your sampling 
sequence, click a row in the table and drag it to the new location. To 
move several rows at once, hold down the Shift key while you click 
sequential rows (or the Control key for split rows) and then drag the 
selected rows to the new location.  

• Reset. If you edit a sampling sequence you imported and decide not to 
keep your changes, you can use the Reset button above the table to 
display the contents of the original file.  

• Save. Use the Save button above the table to save your changes to the 
displayed sampling sequence. You can save the changes in the original 
file or create a new file and leave the old file unchanged. To save the 
changes in the original file, select the file name in the Save dialog box 
and then choose Save. To save the changes in a new file, enter a file 
name in the File Name box and then choose Save.  
 

Exporting a  
sampling sequence 

Follow the steps below to export a sampling sequence from a workflow to a 
text file. Using a text file to store the sampling information allows you to 
create the file at another computer and easily copy and reuse the sequence 
in multiple workflows, or quickly switch the sampling sequence in the 
current workflow. The workflow must contain a Repeat event that is set up 
to use a sampling sequence (i.e., Number of Repetitions is set to Use 
Sampling Sequence).  
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Export To Text File gives you the option to save the sampling sequence 
information outside the workflow. The contents of the table in the 
Sampling Sequence group, including any columns you added, is saved in a 
tab-separated text file (.TXT extension) with the file name you specify.  

To export a sampling sequence: 

1. Right click the table in the Sampling Sequence group.  

 
 

2. Choose Export To Text File in the shortcut menu.  

RESULT displays the following dialog box: 

 
 

3. Enter a file name for the exported file in the File Name box.  
 

4. Use the Browse button to locate and select a folder for saving the 
exported file. 
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5. If you want the table headings to be saved with the data, make sure 
Include Header Row is selected. 
 

6. When you are finished, choose OK to create the text file.  

If Microsoft Excel is installed on the computer, RESULT tries to open 
the text file in Excel. If you see an error message indicating the file is 
not in a recognizable format, ignore it and choose OK to display the 
file’s contents.  

 Note Using the Export To Text File option does not affect the status of the 
workflow. For example, if the sampling information is saved with the 
workflow, choosing Export To Text File creates a text file that contains the 
sampling information but does not associate the text file with the 
workflow.  
 

Editing a workflow When you run a workflow, the software carries out the events in the order 
in which they appear in the workflow navigation frame when you display 
the workflow in RESULT Integration software. You may add and delete 
workflow events and their associated specifications, arrange them in any 
order, and move them in and out of event groups. This section explains 
how to use the commands in the Edit menu and the drag and drop features 
of RESULT Integration software to add, delete and arrange events to create 
functional workflows.  

 Note You cannot edit event and specification names as they are displayed in the 
workflow navigation frame. To edit the name of an event or specification, 
select the event or specification in the workflow navigation frame and then 
edit the name as it appears at the top of the parameters shown in the 
display area.   

Arranging events  
in a workflow 

RESULT Integration software provides Windows drag-and-drop capabilities 
in the workflow tree, allowing you to easily arrange the events in a 
workflow.  

To move an event, use the mouse to select the event name in the workflow 
tree and then hold down the mouse button while you drag the item up or 
down in the list of events.  
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Drag and drop feature of the workflow tree 
 

To place the event in a specific location in the workflow tree, drag the 
event to the workflow event that is immediately above the target location. 
That event should now be highlighted in the workflow tree. Leave the 
event highlighted while you release the mouse button. The “dragged” event 
will appear immediately below the highlighted event.  

To place the event in an event group, drag and then drop the event on the 
highlighted event group. The dragged event will be added to the end of the 
group.  

If you want to place the event immediately after (but not in) an event 
group, drag the event to the highlighted event group and then hold down 
the Shift key on your keyboard while you release the mouse button. The 
dragged event will appear immediately below (but not in) the group.  

To move an event to the first position in an event group, drag the event to 
the second position and then drag the first event down to the second 
position. 

 Note The drag and drop features do not operate on the specification tree. The 
positions of the specification groups are fixed and the sequence of the 
specifications within a group is not relevant to the operation of the 
workflow.  
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Moving between 
screens in a workflow 

RESULT Integration software provides tools to help you easily select a 
previous screen in a workflow.  

 
Use the Back command in the Edit menu to return to the previous screen 
in the open workflow. The Back command is also available as a button in 
the RESULT Integration toolbar. After you use the Back command in the 
Edit menu or the Back button on the toolbar, the Forward command or 
button becomes available in the software.  

 
Use the Forward command in the Edit menu to return to the screen that 
was displayed the last time you used Back. The Forward command is also 
available as a button in the RESULT Integration toolbar.  

 
Cutting items  

from a workflow 
The Cut command in the Edit menu removes the selected event or 
specification from the open workflow and places the cut item onto a 
clipboard (replacing the previous contents, if any exist). After you cut an 
event, you can use Paste to place a copy of the event in another location in 
the open workflow, or into another workflow. (If you shut off your 
computer, the cut item will be erased.)  

Specifications that have been cut may be pasted back into their original 
location on the Details tab or into another workflow.  

 Tip If a cut event produces results that are used elsewhere in the workflow, you 
must select each dependent event and/or specification so the software can 
update them by removing the result for the item that was cut. If the 
dependent items aren’t updated, the workflow may produce errors when 
you run it, since the dependent events and specifications will be unable to 
locate the results that were removed.  
 

Copying items 
to the clipboard 

The Copy command in the Edit menu places a duplicate of the selected 
event or specification onto a clipboard (replacing the previous contents, if 
any exist). After you copy an event, you can use Paste to place a copy of the 
event in another location in the open workflow, or into another workflow. 
(If you shut off your computer, the copied item will be erased.)  

Specifications that have been copied may be pasted back into their original 
location on the Details tab or into another workflow.  
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If a copied event has associated specifications, the duplicate event will have 
the same associated specifications as the original.  
 

Pasting items  
from the clipboard 

After you cut or copy an event or specification, a duplicate of the cut or 
copied item is on a clipboard. Use Paste in the Edit menu to place a copy 
of the item in a specified location in the open workflow, or into another 
workflow. (If you shut off your computer, the cut or copied item will be 
erased.)  

Pasted events are placed after the selected (highlighted) event or, if an event 
group is selected, after the last event in the group. Specifications that have 
been cut or copied may be pasted back into their original location on the 
Details tab or into another workflow.  

The pasted event or specification is an exact copy of the item that was cut 
or copied to the clipboard. For example, if a cut or copied event has 
associated specifications, the pasted event will have the same associated 
specifications as the original.  

If you paste copied items back into the same workflow, the software 
appends a number to the item name to indicate that it is a copy of another 
item in the workflow. For example, if you copy a Collect Polystyrene event 
and then paste one or more copies back into the same workflow, the copied 
items will be named Collect Polystyrene (1), Collect Polystyrene (2), etc., 
so you can tell them apart. 

If the copied event produces results that are used elsewhere in the 
workflow, the duplicate event will produce similar results but those results 
will not be used by other events in the workflow until you add the results 
to those events.  

You can continue to paste copies until you cut or copy another selected 
item or turn off your computer.  

Tips on pasting items in workflows 

• An item that is on the clipboard remains there until you use Cut or 
Copy again. If you turn off your computer, the contents of the 
clipboard are erased. 

• You may not paste cut or copied items into other applications.  
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Deleting items  
from a workflow 

Use Clear in the Edit menu to delete the selected event or specification 
from the open workflow. Unlike cutting items with Cut, clearing an item 
does not place a copy of it on the clipboard.  

If a deleted event is linked to one or more specifications, those 
specifications will not be deleted along with the event. 

How to delete items from a workflow: 

1. Make sure the appropriate tab is selected in the workflow 
navigation frame. 

If you want to delete an event, select the Workflow tab, as shown 
below. 

 

To delete a specification, select the Details tab. 
 

2. Select the item or items that you want to delete. 
 

3. Choose Clear from the Edit menu. 

The following dialog box is displayed:  

 

Choose Yes to delete the selected items. If you choose Cancel, the items 
will not be deleted and will remain in their previous locations in the 
workflow. 
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 Tip You can press the Delete key on the keyboard instead of choosing Clear to 
clear the selected event or specification from a workflow.  
 

Undoing an edit Undo in the Edit menu lets you reverse the effects of various editing 
operations in a workflow, including Add, Move, Cut, Copy, Paste, and 
Clear.  

For example, if you have just deleted an event, you can restore the original 
event (and all of its associated specifications and assigned results) by 
choosing Undo.  

To restore the changes you just reversed, choose Redo from the Edit menu.  

Choosing Undo multiple times will reverse previous, consecutive editing 
operations one operation at a time.  

The Undo command is available only if you are allowed to undo the 
operation you just performed. You cannot undo non-editing operations, 
such as Save Workflow.  
 

Redoing an edit Redo in the Edit menu lets you reverse the effects of an Undo operation.   

For example, if you have just performed an editing operation and then 
reversed the operation by choosing Undo, you can reverse the Undo 
operation by choosing Redo, and then continue where you left off.  
 

Resetting to defaults After editing the parameter settings for a displayed workflow event or 
workflow specification, you can use the Reset command in the Edit menu 
to restore those parameters to the settings displayed when you first selected 
that workflow event or specification. The Reset command is also available 
as a button in the RESULT Integration toolbar.  

 
The Reset command is also available as a button in the RESULT Integration 
toolbar.  
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Adding events  
to workflows 

Workflow events specify a task that will be carried out when the workflow 
is run. The software implements the tasks in the order in which they appear 
in the workflow navigation frame when you display the workflow in 
RESULT Integration software. 

Use the Add command in the Edit menu or the Add button on the toolbar 
to add events to the open workflow. See “Adding events to workflows” in 
this section for more information. 
 

Using the Workflow 
wizard to add components 

to workflows 

Use the workflow wizard in the Edit menu or the Wizard button on the 
toolbar to add the basic components to a workflow in one easy step (i.e., 
the events and specifications needed to collect, measure, archive, and report 
a basic spectrum). You choose which components you want to include 
from a single dialog box. When you close the dialog box, the new workflow 
events appear in the workflow navigation frame. The new events are placed 
in a group located at the end of the workflow. See “Using the workflow 
wizard to create or add to a workflow” in this section for more information. 

 
Testing a workflow When creating a workflow in RESULT Integration, it is helpful to test the 

workflow to make sure it functions properly before transferring the 
workflow to a production system for repeated use. The RESULT Integration 
toolbar includes a convenient tool for testing a workflow. The RESULT 
Integration test feature mimics RESULT Operation, so you can see precisely 
how your workflow will operate in production mode without leaving 
RESULT Integration.  

To test the open workflow: 

1. Select the Test button on the toolbar in the RESULT Integration 
main window or choose Test Workflow from the File menu.  

The software displays the Run Time Test window, as shown below.  
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See “Chapter 1 Getting Started” in the 
“RESULT Operation User Guide” for detailed 
descriptions of the features in the Run Time 

Test window. 
 

 

This window mimics the main screen for RESULT Operation software. 
RESULT Operation is the production application for RESULT.  

The display boxes show logon information for the current user and the 
name of the workflow that is being tested.  

 

The ValPro and Verification indicators, which appear below the display 
boxes, refer to any ValPro instrument qualification and verification 
workflows that must be run with this workflow. These indicators are 
meaningful only when the workflow is run in RESULT Operation 
software. See “Chapter 2 Running Workflows” in the “RESULT 
Operation User Guide” for more information about qualification and 
verification workflows. 
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2. If the workflow contains simulated sample spectra and you want to 
run the workflow using the simulated spectra, select Use Simulated 
Data in the Run Time Test window. 

 

 Note If the workflow is set up to use simulated data for all workflow runs, this 
setting in the Run Time Test window has no effect. See “Sample 
Specifications” in “Workflow Events and Specifications” for more 
information.  
 

3. If you want the workflow to pause after executing each event, select 
Execute One Event At A Time.  

 
 

4. If you want the workflow to restart each time it completes, select 
Run Continuously. 

 

The workflow will keep running until you pause or stop it by choosing 
Pause or Stop in the Run Time Test window.  
 

5. Use the Text Size slider to increase or decrease the size of the text in 
the display area of the Run Time Test window. 

 
 

6. Choose the Go button at the bottom of the window to start the 
workflow. 

The content and configuration of the workflow define how it operates. 
One or more of the following may occur: 

• If the workflow is set up to use simulated data for all workflow 
runs, or if you selected Use Simulated Spectra in the Run Time 
Test window, the workflow simulates data collection by showing 
you any prompts or status information that will appear when the 
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workflow is run normally. However, all workflow events that 
normally operate on the collected spectrum will use the spectra 
stored with the workflow instead. See “Sample Specifications” in 
“Workflow Events and Specifications” for information about 
requiring simulated data for all workflow runs. 

• If the workflow is set up to prompt the operator to select a sample 
for simulation, the following dialog box appears: 

  

Select a simulation sample and then choose OK to run the 
workflow using the stored spectrum. 

• If the workflow is set up to run using collected data, the workflow 
begins. Workflow events are carried out in the order in which they 
appear in the workflow navigation frame when you display the 
workflow in RESULT Integration software.  
 
The status of the workflow appears in the status box at the lower 
left corner of the window, as shown below.  

 

Any operator prompts that were set up in the workflow, instructing 
the operator to prepare for background or sample collection for 
example, will appear on the screen at the appropriate time. 
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• If the workflow is set up to use a sampling sequence that requires 
confirmation from the operator, the following dialog box will 
appear on the screen before the sequence begins:  

 

Use the features in the Sampling Sequence box to edit, import or 
create a valid sampling sequence. See “Creating a sampling 
sequence” and “Importing a sampling sequence” in the previous 
section for more information.  

• If you want to view the spectral data during data collection, select 
the Spectra tab at the top of the Run Time Test window.  
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The first spectrum will be displayed as it is collected. As new 
spectra are added to the spectral window, the spectra are overlaid. 
The most recent spectrum is shown in red.  
 
When viewing the spectral data, RESULT provides a variety of 
options for configuring the display window and manipulating 
displayed spectra. See “Chapter 2 Running Workflows” in the 
“RESULT Operation User Guide” for more information about these 
features.  

• If the workflow contains a run sequence event, the Sequence tab 
appears in the Run Time Test window. The run sequence event 
configures RESULT software to collect and process spectra 
continuously. Continuous data collection provides information 
about samples that change composition over time.  

If you want to view the sequence data during collection, select the 
Sequence tab.  

 

The Sequence tab is divided into two main display areas for 
showing spectral data and measurement results.  

 

The spectral display appears in the upper part of the tab and shows 
the most recent spectrum. The spectral display updates each time 
the instrument collects and processes a new spectrum. The rate of 
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data collection is determined by the resolution, mirror velocity and 
number of scans collected for each spectrum. The spectra are 
displayed in sequence; each spectrum represents a “snapshot” of the 
sample at a particular moment in time. The vertical axis shows 
intensity (the workflow defines the data format) and the horizontal 
axis is in wavenumbers (cm-1). 

Depending upon how the run sequence event is configured in the 
workflow, the lower portion of the Sequence tab may show the 
measurement results calculated by the workflow over the time of 
the data collection. The measurement results can be component 
concentrations from a quantitative analysis, a match value or class 
number from a classification analysis, or peak heights or areas. The 
available results and types depend on the analysis method or 
methods associated with the run sequence event in the workflow.  

You can choose between a text format and a run chart format for 
displaying the measurement results. The text format (shown above) 
provides a running list of the calculated values over the time of the 
data collection. Each time the software collects a new spectrum, it 
recalculates the results and then displays the new values.  

To display the measurement results in a run chart format, select the 
Curves tab at the top of the sequence display.  

 

When the Curves tab is selected, the lower display area may be 
divided into one or more panes.  
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Each pane shows a measurement calculated by the workflow over 
the time of the data collection. The vertical axis shows sample 
concentration (the analysis method defines the component name 
and unit) and the horizontal axis is in seconds. The software adds 
data points to the concentration curves each time it collects a new 
spectrum.  

The run sequence event in the workflow specifies the information 
displayed on the Sequence tab. See “Viewing sequence data while 
running a workflow” in “Chapter 2 Running Workflows” of the 
“RESULT Operation User Guide” for more information about the 
sequence display.  

• If Execute One Event At A Time is selected in the Run Time Test 
window, the workflow executes the first event and then stops. The 
Go button flashes to the Pause button, and then changes to the 
Resume button. When you are ready for the workflow to execute 
the next event, press Resume. Continue pressing Resume until all 
the events have been executed.  

• If the workflow is set up to create a sample report, the report will 
appear in the display area when the workflow is completed. The 
name of the report and the date and time it was created are 
displayed in the report navigation frame to the left of the report as 
shown below.  
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To print the report, use the Page Setup 
and Print buttons at the bottom of the 

window, or move the mouse cursor over 
the display area and click the right mouse 
button to display a shortcut menu. Then 

choose Print from the shortcut menu. Page 
Setup displays a standard Windows printer 

setup dialog box. Print sends the data to 
the specified printer.  

 

The software adds one of the following disclaimers to the end of 
the report, depending on whether you ran the workflow normally 
or with simulated data. 

• Generated in diagnostic mode (if you ran the workflow with 
simulated data).  

• Generated in off-line production mode (if you ran the 
workflow normally).  

This allows you to easily distinguish reports that are created by 
workflows run in RESULT Integration from reports created by 
workflows run in production mode in RESULT Operation. 

• If workflow errors occurred, the errors will be listed in a table in the 
display area, as in the example below. 
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Read the descriptions provided in the table and the suggestions for 
resolving the errors. See “Chapter 6 Troubleshooting” for more 
information about errors that may occur when testing workflows in 
RESULT Integration software. 
 

7. When you are finished testing the workflow and reviewing the 
report, choose the Close button in the lower right corner of the 
window to close the Run Time Test window. 
 

Saving a workflow Use Save Workflow in the File menu or the Save button on the toolbar to 
save the open workflow on a disk.  

To save the open workflow: 

 
1. Choose Save Workflow As from the File menu or choose the Save 

button on the toolbar. 

The Save As dialog box is displayed. 

 

The default folder is the currently selected location for storing 
workflows and methods. See “Setting RESULT Integration Options” in 
“Chapter 1 Getting Started” for information about setting this and 
other directory paths in RESULT Integration software. 
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2. Select a folder for storing the new workflow or create and then 
select a new folder. 
 

3. Enter a descriptive name for the new workflow in the File Name 
box and then choose Save. 

The extension “.WFL” is automatically added to the file name.  

After you choose Save, the file name for the new workflow appears in 
the title bar at the top of the RESULT Integration main window, as 
shown below. 

 

 
Signing  

workflow files 
Before transferring a new workflow to a production system, you should 
digitally sign the workflow file. You may want to sign other files associated 
with the workflow, such as the method files, to completely secure the 
workflow. Applying digital signatures to your files can help ensure their 
authenticity.  

 Note The digital signature features of RESULT software comply with 
21 CFR Part 11 (Title 21 – Food and Drugs of the Code of Federal 
Regulations; Electronic Records; Electronic Signatures; Final Rule, Federal 
Register 62, no. 54, 1997).  

You must enter a valid Windows user name and password to digitally sign a 
file. 

 Note The user name and password must match your Windows user name and 
password exactly, including the letter case.  

To sign a file: 

1. Choose Sign File from the File menu in RESULT Integration. 

The following dialog box appears.  
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2. Use the Files Of Type drop-down list box to select the type of file 
you want to sign.  

The following types of files may be signed: 

• Workflow files (*.wfl) 

• TQ Analyst method files (*.qnt). (Method library files (*.lbd and 
*.lbt) are considered signed when their associated method file has 
been signed, since the library files can only be altered through the 
associated method file.) 

• Spectral data files (*.spa, *.jdx, *.spc, *.csv) 

• Sequence data files (*.srs, *.sri, *.cnc) 

• Report files (*.htm). 

 Note Spectral and report files are typically signed before they are archived by a 
workflow. The archive event may be configured to require digital 
signatures. See “Archive events” in “Workflow Events and Specifications” 
for more information.  
 

3. Select the file you want to sign and then choose Open. 

After you choose Open, the following dialog box is displayed.  
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If you choose Cancel from the 
Digital Signature dialog box, the file 

will not be digitally signed. 

 

 
4. Select the User Name box and enter your Windows user name.  

The name must match your Windows user name exactly. 
 

5. Select the Password box and enter your Windows password.  

The password must match your Windows password exactly, including 
the letter case.  
 

6. Open the Reason For Signature combo box and select an option 
that describes your purpose for signing this file, or select the combo 
box and type a description. 

The options provided in the software are described below.  

• Authorship, to indicate that you created the file. 

• Review, to show that you reviewed the file. 

• Approval, to confirm that you reviewed and approved the file. 

• Responsibility, to indicate that you are responsible for the file but 
didn’t necessarily create it. 

 Note If RESULT is running with the Security Administration application, the 
RESULT administrator may customize the list of reasons based on an 
operator’s job function.  
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7. Select OK to close the dialog box. 

The software should display a message indicating that the file has been 
successfully signed, as shown below.  

 

Your user name is now archived with the file and the file’s contents are 
“stamped” so that any changes which occur after this date and time will 
be detected.  

 Note You can sign a file multiple times by using Sign File again. However, only 
the two most recent signatures will be visible when you view a file’s 
signature information.  

If you are unable to correctly enter your Windows password, the 
following error message appears:  

 

After you choose OK, the following message appears: 

 

If you see these error messages, the file was not digitally signed. To 
retry, use Sign File again to select the file and then enter the correct 
user name and password.  
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Checking file signatures RESULT Integration allows you to easily check whether a file that was 
produced in RESULT software has been digitally signed.  

To check whether a file has been signed: 

1. Choose Check Signature from the File menu in RESULT Integration. 

The following dialog box appears.  

 
 

2. Use the Files Of Type drop-down list box to select the type of file 
you want to check for signature.  

The following types of files may contain signatures: 

• Workflow files (*.wfl) 

• TQ Analyst method files (*.qnt) 

• Spectral data files (*.spa, *.jdx, *.spc, *.csv) 

• Sequence data files (*.srs, *.sri, *.cnc) 

• Report files (*.htm). 
 

3. Select the file you want to check for signature and then choose 
Open. 
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If the file contains one or more digital signatures, an information box 
appears showing the file name and file location, the names of the last 
two people who signed the file, the date and time the file was signed, 
and the reason it was signed, if one was specified, as shown below.  

 

The software displays the following message instead if the file does not 
contain a signature, or if the file was altered after it was signed.  

 
 

Adding operator 
instructions to a 

workflow 

You can create an associated document that contains instructions or a 
standard operating procedure (SOP) for running a workflow. The 
document can then be converted to a portable document format (PDF) file 
and attached to the workflow in RESULT Operation software. You must 
have a copy of Adobe Acrobat software and a current version of Adobe 
Reader installed on your computer to create instructions for use in RESULT 
software and to view those instructions using RESULT. 

If an operator running RESULT Operation selects a workflow that has an 
attached instruction file, then the file will be loaded along with the 
workflow and the operator will be able to view the instructions before 
running the workflow. See “Chapter 1 Getting Started” in the “RESULT 
Operation User Guide” for information about viewing operator 
instructions when running a workflow.  
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You can use any word processing or text editor application to create the 
instructions document. When the document is complete, use the Adobe 
Acrobat software application to convert the document to the portable 
document format (PDF). 

 Note Adobe Acrobat provides tools to sign *.pdf files if you need to have these 
documents signed to comply with regulations or procedures.  

Store the pdf file (*.pdf extension) in the same directory as the workflow 
for now. When you transfer the workflow to RESULT Operation software, 
make sure you transfer the PDF file along with the workflow. See 
“Transferring Workflows To RESULT Operation Software” in the next 
section for more information. 

See “Setting Up A New Workflow” in the “RESULT Software 
Administration” manual for information about attaching instructions to a 
workflow. You can attach one instruction file to each workflow. 
 

Transferring 
a workflow 

to RESULT Operation 

After you have completed and signed a new workflow, the workflow is 
ready to be transferred to RESULT Operation, which is the production 
application for RESULT software. RESULT Operation can be running on the 
same workstation as RESULT Integration or on a different workstation or a 
production system. 

You can transfer workflows to RESULT Operation by copying the workflow 
and its associated files to the proper workstation and placing the files in the 
proper directory and path. 

A workflow can have an associated document that contains instructions or 
a standard operating procedure (SOP), images for HTML reports, 
analytical methods, simulation data, and verification workflows. These 
items must be transferred along with the workflow in order for the 
workflow to function properly in RESULT Operation software. We 
recommend collecting and storing the workflow and its associated files in 
one directory to facilitate the transfer. 

To move a workflow in order to run the workflow in RESULT Operation 
software, copy the files listed below to the proper workstation and place 
them in the current directory path in RESULT Operation.  
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 Workflow file (*.wfl). If possible, store the workflow in the directory 
designated for workflows and methods, as specified in the RESULT 
Options dialog box in RESULT Operation software. If the workflow 
cannot be stored in that directory, make sure the workstation has access 
to the directory where the workflow is actually stored. 

 Verification workflow file (*.wfl). If the workflow requires a 
verification workflow, then store the verification workflow in the same 
directory as the workflow.  

 Note When setting up workflows in RESULT Operation, set up the verification 
workflow before setting up the associated production workflow. See 
“Chapter 6 Managing Workflows” in the “RESULT Software 
Administration” manual for information about setting up a new workflow 
in RESULT Operation software.  

 Method files (*.qnt). If the workflow has associated TQ Analyst or 
other method files, store the method files in the same directory as the 
workflow.  

 Method library files or other run-time files. If using a TQ Analyst 
method, store the methods’ associated library files (*.lbd and *.lbt) in 
the same directory as the method. (There is no need to copy the 
spectral data files for the method standards to RESULT Operation 
software. Copies of the standards used to calibrate a TQ Analyst 
method are automatically stored in the method library files.) 
 
If using a third-party method, copy the proper run-time files to the 
same directory as the third-party method. See “Using third-party 
methods with RESULT” in Chapter 4 Tools for Building Methods and 
Viewing Spectra” for more information.  

 Image files (*.bmp, *.gif, *.jpeg, *.png, etc.). If the workflow contains 
a report event that specifies one or more image files, to be placed in a 
report heading or table for example, store the image files in the 
directory designated for HTML images, as specified in the RESULT 
Options dialog box in RESULT Operation software.  

 Instructions file (*.pdf). If the workflow has an associated document 
with instructions or a standard operating procedure (SOP), store the 
document in the directory designated for instructions, as specified in 
the RESULT Options dialog box in RESULT Operation software. If the 
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instructions cannot be stored in the standard directory, then make sure 
the workstation has access to the directory where the instructions file is 
actually stored. The instructions document must be converted to 
portable document format (PDF) before it can be attached to the 
workflow. See “Operator Instructions” in the previous section for 
information about creating instructions files and converting them to 
the portable document format.  

 Simulation files for sequence collection (*.sri). If the workflow 
contains a run sequence event that has an associated simulation sample 
(used for simulated runs of the workflow), store the interferogram 
(*.sri) data for the simulation sample in the same directory as the 
workflow.  

 Note Other types of data (*.spa and *.spg files) selected for simulated runs of a 
workflow are automatically stored with the workflow and need not be 
present as a separate file in order to run the workflow in simulation 
mode.  

 Note To determine the proper directory paths for the above items in RESULT 
Operation software, see “Chapter 4 Setting RESULT Operation Options” in 
the “RESULT Software Administration” manual.  

Use the Windows Explorer program in your Programs menu to transfer the 
files. The Programs menu is available from the Start menu on your 
Windows taskbar. See your Windows documentation for information 
about using Windows Explorer.  
 

Exporting  
workflow files 

The RESULT Integration File menu includes an Export command, which 
allows you to export workflows or the simulation spectra attached to a 
workflow to separate files in various formats so they can be viewed or 
printed from other applications.  

Read this section to learn about the Export Files dialog box and the options 
for exporting workflows and their associated spectra. 
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Export Files dialog box To export files from a workflow, first start the RESULT Integration 
application. From the RESULT Integration main window, open the File 
menu and then choose Export. The Export Files dialog box is displayed, as 
shown below.  

 

You can use this dialog box to export a workflow to a text file or the 
simulation spectra for a workflow to individual spectral files. The exported 
workflow files can be set up to show only the workflow contents and 
structure for both the Workflow tab and the Details tab, or the structure 
and a complete listing of the parameter settings for each workflow event 
and specification. You can export files from the open workflow or select a 
workflow file saved on a disk. The simulation spectra will be exported to 
individual spectral data files in the Nicolet spectrum file format (*.spa file 
name extension).  
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Exporting a workflow Follow these instructions to export a workflow to a text file.  

To export a workflow to a text file: 

1. Select a workflow. 

To export the open workflow, select the Current Workflow option in 
the Select Workflow group. 

 

To select a different workflow, select the Workflow File option and 
then use the Browse button to select a workflow file. Workflow files 
have the *.wfl file name extension. You may browse to any disk or 
directory to locate a workflow file. 
 

2. Select the Export Workflow check box. 

 
 

3. Choose a file format for the exported workflow.  

The available file formats are described below: 

• Standard HTML, which creates a standard hypertext markup 
language (HTML) text file with an *.htm file name extension. 
HTML documents are viewable by RESULT software, as well as web 
browsers and other applications that can open HTML files. 

• Text file, which creates a standard text file with a *.txt file name 
extension. Text files can be viewed from any text file editor such as 
NotePad.  
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• Unicode HTML, which creates a Unicode HTML text file with an 
*.htm file name extension. You may prefer the Unicode HTML 
format if your document contains text from double-byte character 
sets such as Kanji.  

• Unicode text file, which creates a Unicode text file with a *.txt file 
name extension. Unicode text files can be viewed from any text file 
editor such as Notepad. 
 

4. Specify a path and file name for the exported workflow or leave the 
default path and file name.  

You can enter a path and file name in the File Name box or use the 
Browse button to specify the path and file name. If you leave the 
default path and file name, the exported workflow file will be saved in 
the C:\\RESULT Data\Archive folder using the same name as the 
workflow file but with a *.htm or *.txt extension.  

 Note If you leave the default file name and that file already exists in the specified 
location, the software will overwrite the existing file.  
 

5. If you want the exported file to include the parameter settings for 
each workflow event and specification, select the following check 
box.  

 

If you leave this check box cleared, the software exports the workflow’s 
basic contents and structure for both the Workflow tab and the Details 
tab, but not the parameter settings. 
 

6. If you selected one of the text file formats in step 3 above, use the 
following check box to indicate whether you want the text file to 
include bullet symbols. 

 
 

7. Choose the Export button at the bottom of the dialog box to create 
the exported file.  
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8. Select another workflow to export or, if you are finished exporting 
files, choose Done. 

The software saves the file using the directory, path and file name you 
specified in the Export Files dialog box in step 4 above. You can use 
any text editing application, such as the Windows Notepad program, to 
open, edit, and print an HTML or text file.  
 

Exporting  
simulation spectra 

RESULT allows you to attach spectra to a workflow in order to run the 
workflow without stopping to collect data. Follow the instructions in this 
section to export the simulation spectra attached to a workflow to 
individual spectral data files. You can export the simulation spectra from 
the open workflow or select a workflow file saved on a disk. When 
exporting simulation spectra, keep in mind that the software automatically 
exports all the simulation spectra for all the sample and background 
specifications included in the workflow. Depending upon the format you 
select for the exported sample data, the software may need an appropriate 
background spectrum to complete the processing. If the selected format 
requires a background but the simulation spectra do not have associated 
backgrounds, the software displays an error message.  

The simulation spectra will be exported to individual spectral data files in 
the Nicolet spectrum file format. Each file is named with the spectrum title 
and a *.spa file name extension.  

To export the simulation spectra saved with a workflow: 

1. Select a workflow. 

To export the simulation spectra from the open workflow, select the 
Current Workflow option in the Select Workflow group. 

 

To select another workflow, select the Workflow File option and then 
use the Browse button to select a workflow file. Workflow files have the 
*.wfl file name extension. You may browse to any disk or directory to 
locate a workflow file. 
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2. Select the Export Simulation Spectra check box as shown below. 

 
 

3. Specify a path for the exported files. 

You can enter a path name, or use the Browse button to select the path 
name, or leave the default path name.  
 

4. If the simulation spectra in the selected workflow have associated 
background spectra and you want to use the associated 
backgrounds to reprocess the simulation spectra to another data 
format, select the following check box.  

 

If this check box is cleared, the software exports the simulation spectra 
as interferograms and the option to select the data format (see step 5 
below) is unavailable in the software.  

 Note If this check box is selected and you choose a data format that requires 
background spectra but the simulation spectra do not have associated 
backgrounds, the software displays an error message.  
 

5. Choose a data format for the exported simulation spectra.  

The following options are available: 

• Interferogram 

• Single beam 

• % Transmittance 

• Absorbance 

• % Reflectance 



 

Thermo Scientific RESULT Integration Software User Guide 95 

• Log 1/R 

• Kubelka-Munk 

• Single beam raw 

See “Collect events” in “Workflow Events and Specifications” for 
descriptions of these data formats. 
 

6. Choose the Export button at the bottom of the dialog box to create 
the data files.  
 

7. Select another workflow or, if you are finished exporting simulation 
spectra, choose Done. 

The files are saved in Nicolet spectrum format in the directory and 
path you specified in the Export Files dialog box in step 3 above. Each 
file is named with the spectrum title and a *.spa file name extension. 
You can use the TQ Analyst method development application to view 
or print a Nicolet spectral file. Exported files can also be used as 
method standards or representative samples for development purposes.  
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Chapter 4 Tools for Building Methods 
and Viewing Spectra 

RESULT Integration is designed to work hand-in-hand with Thermo 
Scientific TQ Analyst™ method development software for seamless method 
creation and design, including the collection of standards. TQ Analyst is a 
sophisticated yet easy-to-use software package for developing analytical 
methods for near-infrared (NIR) and other spectroscopic applications. 
RESULT is also compatible with several method development applications 
created by other manufacturers.  

This chapter describes how to use the commands in the Tools menu of 
RESULT Integration software and your TQ Analyst or other compatible 
method development software to build an analytical method and assign the 
method to a measure event in a workflow. You will learn how to configure 
and collect the method standards and, if using TQ Analyst software, to 
import the method standards, select the analysis type, specify the analysis 
region or regions, and calibrate, save and test the method. The chapter also 
covers the Quick Collect and View Spectra tools, which may be used to 
collect and view spectra using RESULT Integration software. 
 

Configuring standards Standards are samples of known composition used to develop a quantitative 
or qualitative (classification) model. Use Configure Standards in the 
RESULT Integration Tools menu to configure and then collect standards in 
order to use those standards to build a quantitative or qualitative method 
for use with a measure event in a workflow.  

To configure standards in RESULT Integration, simply specify any user 
prompts that will be needed for collecting the spectra of the standards, such 
as a prompt to request concentration values from the operator or a 
sampling sequence, and define how and where the spectra will be saved. 
You may configure standards differently for each measure event that is 
included in a workflow. You can also configure and collect the same set of 
standards for use by two measure events in a workflow.  
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 Note In RESULT Integration software, standards are based on a measure event in 
a workflow (and its associated collect event). You must first open an 
appropriate workflow before you can configure the standards and begin 
collection. If you attempt to configure or collect standards without opening 
a workflow that contains at least one measure event, the software displays 
the following message.  

 

The measure event requires an associated collect event. The measure event 
should also be linked to a functional measurement specification. See 
“Workflow Events and Specifications” for information about setting up 
collect and measure events in a workflow.  
 

Setting up the  
collection of standards 

To specify how to collect the spectral data for the standards for a given 
workflow: 

1. Open the workflow that requires standards. 

The workflow must contain at least one measure event. 
 

2. In the RESULT Integration main window, open the Tools menu and 
choose Configure Standards.  

The software opens the Configure Standards dialog box with the 
Collect tab selected.  
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3. Select the measure event that requires standards by choosing an 
option in the Measure Event drop-down list.  

The list includes the name of every measure event in the current 
workflow.  

 Note The selected measure event should be linked to a functional measurement 
specification. See “Measurement Specifications” in “Workflow Events and 
Specifications” for information about setting up measurement 
specifications in a workflow.  

If the workflow contains a Configure Temperature/Pressure event, a 
Temperature/Pressure Event list box appears on the Collect tab.  
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The Configure Temperature/Pressure event defines the temperature 
and pressure values that will be used to calculate the component 
concentrations of the standards. 
 

4. If the Temperature/Pressure Event list box appears on the Collect 
tab, use the list box to select the appropriate Configure 
Temperature/Pressure event for the standards.  
 

5. If the current workflow contains multiple measure events and you 
want to use the same standards for a second measure event, select 
the following check box.  

 

When you select the check box, the Measure Event list box directly 
below the check box is enabled. The drop-down list includes the names 
of the remaining measure events in the workflow.  

Choose a name in the Measure Event drop-down list.  

 

The second measure event can occur anywhere in the workflow. If both 
measure events operate on the same collection result, the software 
collects one set of spectra and uses both measure events for the analysis. 
If the second measure event operates on the spectra (results) from a 
different collect event, then the software will collect two spectra from 
each standard and use the first collect/measure event pair to analyze the 
first set of spectra and the second collect/measure event pair to analyze 
the second set of spectra.  

This feature allows you to use the same set of standards to collect 
spectra for two different measure events, or two collect/measure event 
pairs, at the same time. This is useful for measuring a combination of 
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sample characteristics that aren’t (or can’t be) combined in one 
analytical method, such as collecting both transmission and diffuse 
reflection data using the MultiPro Autosampler.  
 

6. Choose a method the operator will use to specify information about 
the standards at run time by selecting an option in the Sample 
Information group.  

When Configure Standards is set 
up to collect standards for two 

measure events (see step 4 above), 
you must use a sampling sequence 

to specify information about the 
standards at run time. 

 

The options include: 

• No sample prompt. The software collects each standard without 
prompting the operator to enter a title or other information.  

 Notice If you plan to use a compatible third-party application to develop your 
method, set Sample Information to No Sample Prompt. The sample 
prompt features are available only for methods developed using TQ Analyst 
software.  

• Prompt for sample title. Before collecting each standard, the 
software displays a prompt asking for the title of the standard. The 
user must enter a title before the software will continue. Keeping 
this feature selected is helpful if your organization has specific 
naming conventions you want to use when titling each standard.  

The titles are saved along with the spectral data for the standards. 
The titles also appear in the TQ Analyst standards table in default 
mode, after the standards have been imported to that application, 
and in the TQ Analyst spectral windows when the spectra are 
displayed.  

 Note The title is a descriptive name saved within a spectral file; it is not the file 
name.  
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• Prompt for title and concentrations (or class name). This option 
operates differently depending on whether the selected measure 
event is linked to a quantitative, qualitative, or spectral 
measurement method.  

For quantitative methods. Select this option if you want the operator 
to enter the concentration values of the components in each 
standard as they are being collected. The software will display a 
dialog box prompting the user to enter the concentration value of 
each component before collecting each standard. After the 
concentration values have been entered, the software displays a 
second dialog box requesting a title for the standard.  

If you don’t select this option, then the concentration values for the 
standards will need to be entered when developing the method in 
TQ Analyst or other method development application. 

For qualitative methods. Select this option if you want the operator 
to specify the correct class for each standard as it is being collected. 
The software will display a dialog box prompting the user to 
indicate the type of material he or she is measuring and present the 
class names from the qualitative method associated with the 
measure event specified in the Configure Standards dialog box. The 
operator dialog box will look something like the following: 

  

The operator must indicate the sample material being analyzed by 
selecting a material in the list and then choose OK.  
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If you don’t select this option to prompt for the spectrum title and 
class, then the correct classes for the standards will need to be 
specified when developing the method in TQ Analyst or other 
method development application.  

For spectral measurement methods. If the selected measure event is 
linked to a measurement specification for a spectral measurement 
method, select one of the other Sample Information options.  

 Note Spectral measurement methods do not require standards. However, you 
can still use Configure Standards and Collect Standards to set up and test a 
spectral measurement method.  

• Use sampling sequence. The software uses the sample titles and 
concentration data (or class index numbers) listed in the table at the 
bottom of the Configure Standards dialog box (see the next step for 
details). This option is selected automatically when the Configure 
Standards dialog box is set up to collect standards for two measure 
events in a workflow. See step 5 above to learn how to configure 
standards for two measure events.  
 

7. If you selected the Use Sampling Sequence option in the previous 
step, use the Sampling Sequence group to enter the sample 
information.  

The group is enabled only when the Use Sampling Sequence option is 
selected for Sample Information. If you are collecting standards for a 
quantitative method created with TQ Analyst software, the names of 
the components in the associated method are listed in the table as 
shown in the example below. 
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If collecting standards for a qualitative method that contains multiple 
classes, a class index column appears in the table instead of the 
component names.  

The sampling sequence must specify a sample name, a sample 
identification code (or position number if using an autosampler), and 
component concentrations (or a class index number) for each standard. 
The information may be entered manually or imported from a text file. 
Right click in the table to display a shortcut menu with options for 
adding rows and columns to the table. See “Using a Sampling Sequence 
to collect standards” in the next section for more information.  
 

Setting up the  
archiving of standards 

To specify how to save the spectral data for the standards: 

1. Select the Save tab. 

The following information is displayed. 

 
 

2. Use the Spectrum Format list box to select a format for archiving 
the spectra of the standards. 



 

104 RESULT Integration Software User Guide Thermo Scientific  

The following options are available:  

• Nicolet (*.SPA). This is the preferred format for spectra, and is 
compatible with Thermo Scientific spectroscopy applications 
including TQ Analyst and RESULT. Data that are stored in the 
Nicolet spectrum format contain complete information about the 
conditions used for data collection as well as the archived sample 
and background interferograms, and are compatible with the digital 
signature features of RESULT software.  

• JCAMP-DX (*.JDX). This file format is compatible with other 
software applications used in the industry, allowing exchange of 
spectral data between various instruments. JCAMP-DX uses 
printable ASCII characters and provides some file header 
information.  

• Galactic (*.SPC), which is a binary format that is compatible with 
other applications and other types of data in the industry, especially 
spectral and chromatographic data. Galactic files include some file 
header information.  

 Notice If you plan to use a compatible third-party application to develop your 
method, select the Galactic option for Spectrum Format. Galactic works 
with third-party method development applications that are compatible 
with RESULT.  

• Comma-Separated Values (*.CSV). This option creates a text file 
that specifies each data point in the spectrum as a set of X and 
Y values. The values may be separated by a list separator (defined 
by the Windows regional settings) or a tab. CSV formatted files can 
be read by any compatible spreadsheet or other program.  
 

3. Use the Path text box to enter the path and folder that will be used 
to archive the spectra, or use the Browse button to locate, or create 
and then select an appropriate folder.  
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When using Browse to choose a 
directory path, spectral files do not 

appear in the Browse dialog box. 

 

Creating a folder for a set of standards can help you easily locate and 
select those standards when importing them into TQ Analyst or other 
method development application. 
 

4. If you want to require digital signatures to archive the spectral files, 
select the Require Digital Signature check box.  

 Notice If you plan to use a compatible third-party application to develop your 
method, clear the Require Digital Signature check box. The digital 
signature features are available only for methods developed using 
TQ Analyst software.  

Using digital signatures for spectral files can help ensure the 
authenticity of the data. When this feature is selected, after you collect 
the spectrum of each standard, the software will open a dialog box 
prompting the user to enter his or her Windows user name and 
password to sign the file. The software will request the digital signature 
when the standards are collected in RESULT Operation or RESULT 
Integration software.  

You have three attempts to enter your password correctly when digitally 
signing a file. If you are unable to correctly enter your Windows 
password or if you cancel the Digital Signature dialog box, the 
following error message appears:  
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If you see this error message, the files are not archived.  

You can use the Check Signature feature in the File menu of RESULT 
Integration software to determine whether a specific file has been 
signed. See “Checking File Signatures” in “Chapter 3 Creating and 
Editing Workflows” for more information. 

To check for signatures in spectral files from RESULT Operation 
software, use the query feature to display the archived spectra in the 
report navigation frame. The status box will indicate the 
signed/unsigned status of the selected file. 

If a file has been signed, both applications show the name of the person 
who signed the file, the date and time the file was signed and the reason 
it was signed, if one was specified. 

Files that have been signed and then altered will be reported as 
“unsigned” by both applications. 

 Note If you collect unsigned standards, you can ensure the authenticity of the 
data after you import the standards into TQ Analyst by signing the 
TQ Analyst method file.  
 

5. Use the File Name group to specify how the spectral files will be 
named. 

The following options are available: 

• Use sample title. This option is available in the software only when 
the Sample Information feature on the Collect tab is set to Prompt 
For Sample Title or Use Sampling Sequence. If you elect to use the 
sample titles for the file names, the software will archive the spectra 
using the titles the operator enters at run time or the titles specified 
in the sampling sequence. The file names of the archived spectra 
will match the titles exactly.  
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• Name files automatically. Select this option if you want the 
software to name the files automatically. You can specify whether a 
base name will be used to archive the files, and select whether a 
globally unique identifier (GUID), date stamp, index, spectrum 
title or any combination of these will be added to the file name.  

Base name. If you want to include a base name when the files are 
named automatically, enter a name in the Base Name box. If you 
specify a base name, the software will include that name at the 
beginning of the file name of each standard. This step is 
recommended because creating a base name for a set of standards 
can help you easily identify those standards after they are archived. 
The base name is also used by RESULT Integration to identify 
which standards to import into TQ Analyst when building an 
analytical method. If you don’t specify a base name, the files will be 
named with any file name options selected in the File Name group, 
such as a GUID or date stamp, and no prefix.  

Add GUID. If you want the software to add a globally unique 
identifier (GUID) to the file names of the standards, select Add A 
GUID. A GUID is a string of characters generated by the software 
as an identifier for a particular file. Each GUID is unique and 
cannot be used for more than one file.  

Add date and time. If you want the software to add a date stamp to 
the file names of the standards, select Add Date And Time. The 
software adds the date stamp immediately after the base name.  

Add index. If the software is set up to collect multiple standards 
without operator intervention, you can use the Add Index option to 
add an index number to the file names of the standards. The index 
is a three-digit index number that increases by one each time it is 
applied (i.e., 001, 002, 003). The software adds the index 
immediately after the base name.  

 Note If a GUID, date stamp, and index are used, the file name includes the base 
name, followed by the GUID, followed by the date stamp, followed by the 
index.  

Add spectrum title. If you want the software to add the spectrum 
title to the file names of the standards, select Add Spectrum Title. 
The software will archive the spectra using the titles the operator 
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enters at run time or the titles specified in the sampling sequence. 
The titles will be appended to the base name and any other file 
name option selected in the File Name box.  

 Note For detailed examples of how these automatic file naming option can be 
used to archive spectral data, see “Archive events” in “Workflow Events and 
Specifications.”  
 

6. When you are finished configuring the standards, choose OK to 
close the Configure Standards dialog box.  

Choose Cancel to close the dialog box without saving your settings. 

When you are ready to collect the standards, in the RESULT Integration 
main window open the Tools menu and then choose Collect 
Standards. RESULT Integration collects standards based on how they 
were configured in the Configure Standards dialog box, along with the 
parameters specified in a collection and measure event in a workflow. 
See “Collecting Standards” in the next section for more information. 
 

Collecting standards Use Collect Standards in the RESULT Integration Tools menu to collect the 
standards for a quantitative or qualitative method. Standards collected in 
RESULT Integration may be used to build a TQ Analyst or other method 
for use with a measure event in a workflow. You may also use Collect 
Standards to update a method model by adding standards to the method.  

RESULT Integration collects standards based on how they were configured 
in the Configure Standards dialog box, along with the parameters specified 
in a collection and measure event in a workflow. The procedure for 
collecting a standard involves collecting a background spectrum and then 
collecting sample data to produce a spectrum. A background is a reference 
spectrum that accounts for the unique optics of the sampling module or 
accessory and the instrument. The background spectrum is the result of the 
output of the source, the response of the beamsplitter optics, sampling 
module or sample holder, and detector and any atmospheric absorptions 
inside the instrument. Each sample spectrum is ratioed against a 
background so that the final spectrum is free of these features.  
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 Note In RESULT Integration software, standards are based on a measure event in 
a workflow. You must first open an appropriate workflow and configure 
the standards before you can begin collection. See Configuring Standards 
in the previous section for more information.  

To collect the standards for a measure event in a workflow: 

1. Make sure an appropriate workflow is open and configured for 
collecting standards. 

See “Configuring Standards” in the previous section for instructions. 
 

2. Choose Collect Standards from the Tools menu in the RESULT 
Integration main window. 

The software opens the Run Time Test window, as shown below:  

See “Testing a Workflow” in 
“Chapter 2 Creating and Editing 

Workflows” and “Chapter 2 Running 
Workflows” in the “RESULT Operation 

User Guide” for descriptions of the 
features in the Run Time Test window. 
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3. When the instrument and sample material are prepared for data 
collection, choose Go. 

 Note RESULT Integration collects standards based on how they were configured 
in the Configure Standards dialog box, along with the parameters specified 
in the collect event associated with the measure event that requires 
standards. If you are unfamiliar with data collection, find the appropriate 
chapter for the sampling module you plan to use in your Antaris User’s 
Guide and run the procedure for Your First Experiment.  
 

4. If the standards are configured to prompt for concentration values 
or class names, enter those items when requested by the software. 

An example of a concentration amount prompt is shown below. 

 

Enter a real number (a number that can include a decimal point). 
Always enter the value in the unit requested in the dialog box. 

An example of the dialog box for selecting a class name is shown below. 
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Select the appropriate class name from the list, and then chose Accept. 
Choose Reset to clear the selection if you have chosen the wrong class 
name. 

5. If the standards are configured to prompt for titles, enter the title of 
the standard at the software prompt, as shown below. 

The titles are saved along with the 
spectral data for the standards. The 
titles also appear in the TQ Analyst 

standards table in default mode, after 
the standards have been imported to 

that application, and in the 
TQ Analyst spectral window when the 

spectra are displayed. 
 

 
Enter the title in the text box. Choose Accept to save the title and close 
the dialog box, or choose Reset to clear the text box if you have made 
an error. 

The software begins collecting data using the parameters set in the 
workflow. You can view the status of the collection in the status 
indicator at the lower left corner of the Run Time Test window. 

When the software has finished collecting data, it displays the spectrum 
in the display area of the window and opens the following dialog box: 

 
 

6. Choose “Yes” to save the spectrum you just collected. 

If you believe an error occurred during sample preparation or 
collection, or if the spectrum does not look reasonable, choose No.  
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7. If the standards were configured to require digital signatures for 
archiving, the software displays the following dialog box. 

 

Enter your Windows user name in the User Name text box, and your 
password in the Password text box. The user name and password must 
match your Windows user name and password exactly, including the 
letter case.  

Select the Authorship option from the Reason for Signature drop-down 
list, or enter another appropriate reason for the signature, and choose 
OK.  

The spectrum is given a unique file name based on the file base name, 
if one exists, along with a globally unique identifier (GUID), date 
stamp, or other file name suffix selected in the Configure Standards 
dialog box. The file is stored in the location that was specified in the 
Configure Standards dialog box in the previous chapter. 

 Note You have three attempts to enter your password correctly when digitally 
signing a file. If you are unable to correctly enter your Windows password, 
or if you choose Cancel from the Digital Signature dialog box, the file will 
not be saved and the software will display the following message: 
 

 
 
Choose OK to close the message.  
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8. If you are collecting standards manually, prepare the instrument 
and the next standard for data collection and then choose Go in the 
Run Time Test window.  

Follow steps 3 through 7 for each standard you need to collect. 

If you are using an autosampler with a sampling sequence to collect the 
standards, the software will automatically position the next standard for 
data collection and begin collecting the data as defined in the sampling 
sequence and the Configure Standards dialog box.  
 

9. When you are finished collecting standards, choose Close in the 
Run Time Test window. 

You can collect standards again with the same settings as long as the 
workflow is open. If you close the workflow, you will need to configure 
standards again before collecting them. 
 

Building a 
TQ Analyst method 

Use Build TQ Analyst Method in the RESULT Integration Tools menu to 
build a new TQ Analyst method for use with a measure event in a 
workflow. RESULT Integration begins by building a core method based on a 
set of standards, along with the parameters specified in the measure event 
and its associated measurement specification. Then it opens the 
TQ Analyst application, allowing you to specify the spectral region for the 
analysis and to calibrate and save the new method. You can collect the 
standards in RESULT Integration or RESULT Operation software or another 
spectroscopy application that is compatible with RESULT and TQ Analyst.  

 Note In RESULT Integration software, methods are based on a measure event in a 
workflow. You must first open an appropriate workflow and configure and 
collect the standards before you can begin building a method. See 
“Configuring Standards” and “Collecting Standards” in the previous 
sections for more information.  

 Note The Build TQ Analyst Method command in the RESULT Integration Tools 
menu works only for methods created using TQ Analyst method 
development software.  
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To build a TQ Analyst method for a measure event in a workflow: 

1. Make sure the correct workflow is open and appropriate standards 
have been collected.  

See “Configuring Standards” and “Collecting Standards” in the 
previous sections for more information. 
 

2. Choose Build TQ Analyst Method from the Tools menu in the 
RESULT Integration main window. 

The software opens the Build TQ Analyst Method dialog box.  

 
 

3. Select the measure event that requires a TQ Analyst method by 
choosing an option in the Measure Event drop-down list. 

The list includes all of the measure events in the current workflow.  
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 Note The selected measure event should be linked to a functional TQ Analyst 
measurement specification. See “Measurement Specifications” in 
“Workflow Events and Specifications” for information about setting up 
measurement specifications in a workflow.  
 

4. If you want to create a new TQ Analyst method for the selected 
measure event, select Create TQ Analyst Method.  

Leave the check box cleared if the selected measure event and its 
associated measurement specification point to an existing TQ Analyst 
method, and you simply want to add standards to that method.  

When Create TQ Analyst Method is selected, the rest of the parameters 
in the group become available, as shown below. 

 

• File Name. Use this text box to specify a file name for the new 
TQ Analyst method. If you leave the File Name box blank, the 
software will use the name of the selected measure event for the 
method file name.  

• Import Selected Standards. Select this option if you want to 
import standards to your new method. To use this option, before 
building the method, you must collect the spectrum of each 
standard and save the spectrum in a separate file on a disk. All of 
the standards must be collected using the same parameter settings 
and conditions.  
 
If you clear this option, the software creates the method but doesn’t 
import standards. You will need to import the standards directly 
into TQ Analyst after the method has been created.  

• Link Method To Selected Measure Event. Select this option if 
you want to link the new method to the selected measure event. 
When this option is selected, the software automatically selects the 
file name of the new TQ Analyst method in the TQ Analyst File 
Name list box, which is located on the measurement specification 
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associated with the selected measure event. If you clear this option, 
then the new method will still be created based on the selected 
measure event, but it won’t be linked to a measure event in a 
workflow.  
 

5. If you are importing standards, use the features in the Method 
Standards group to specify the standards you want to import. 

If you are not importing standards, then skip to step 5.  

 

• Path. Use this entry box to specify the path where the method 
standards are located, or choose Browse and select a path. The 
default path is the path specified in the Options dialog box in 
RESULT Integration software (see “Setting RESULT Integration 
options” in “Chapter 1 Getting Started” for details). However, you 
can select standards that are located in a different path by typing 
the path in the text box or by choosing Browse to open a standard 
Windows Browse dialog box, as shown below. 

Spectral files do not appear in the 
Browse dialog box when choosing a 

directory path. 
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If you choose Browse, navigate to the correct path in the Browse 
dialog box, and then choose Select. The dialog box closes and the 
selected path appears in the Path text box in the Build TQ Analyst 
Method dialog box. 

• Select All Files With Base Name. If importing multiple standards 
that all have the same base name, leave this check box selected. If 
you want to import a single standard or a group of standards that 
have unique file names, clear Select All Files With Base Name. 

• Base Name. If the file names of all the standards have the same 
base name, you can use the base name feature to quickly select 
those standards. Make sure Select All Files With Base Name is 
selected (see above) and then enter the base name in the Base Name 
box, or choose Browse to search for a representative standard. After 
you select a standard, its base name appears in the Base Name box 
in the Build TQ Analyst Method dialog box.  
 
If you want to import a single standard, make sure Select All Files 
With Base Name (see above) is cleared and then use the Base Name 
box to specify the standard. You can type the file name of the 
standard in the Base Name box or choose Browse to search for the 
standard. After you choose Browse, the software opens a standard 
Windows Open dialog box that points to the appropriate path, and 
you can select the standard. After you select the standard, its file 
name appears in the Base Name box in the Build TQ Analyst 
Method dialog box. 
 
If you want to import a group of standards that have unique file 
names, make sure they are located in the specified path and leave 
the Base Name box blank. The software will add all the standards 
located in the specified directory and path or use Date Options to 
limit the selected standards in that directory. 

• Date Options. Use the Date Options to broaden or limit the 
selected standards. Leave the default setting (All Dates) for Date 
Options to select all standards that have the specified base name, if 
one was entered, and are located in the specified directory and path. 
If you want to limit the selected standards to include only those 
files which were collected on a certain day or time, or in a date or 
time range, set the date or time option by selecting an item in the 
Date Options drop-down list. Depending on the selection you 
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make, the Starting Date and/or Ending Date boxes may become 
available. You can change the dates in these boxes by: 

- Typing the appropriate dates(s) in the boxes; 

- Selecting a portion of the date and using the arrow keys on your 
keyboard to adjust the date; or 

- Selecting the drop-down arrow to the right of the box. If you select 
the drop-down arrow on one of the date boxes, the software opens 
a calendar, as shown below. 

 

Choose the date from the calendar with your cursor. Use the arrow 
buttons at the top of the calendar to navigate to the next and 
previous months.  

You can change the time by typing the appropriate time in the box, 
or by selecting a portion of the time and using the arrow keys on 
your keyboard or the Up and Down buttons to the right of the box 
to change the time. 

• Usage. Specify the usage of the selected standards by selecting an 
option in the Usage drop-down list. Select one of the following 
options. 

- Calibration. Calibration standards will be used to create the 
method model during calibration. 
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- Validation. TQ Analyst uses validation standards to calculate a 
performance index after the method is calibrated.  

- Correction. Correction standards may be used to create a 
correction curve for a TQ Analyst quantitative method. 

- Ignore. Standards that have the Usage property set to “Ignore” are 
not used for calibration, performance index, or other calculations in 
a TQ Analyst method.  

The standards will have this property set when they are imported to 
TQ Analyst. When working with a method in TQ Analyst, you 
may change the usage setting for a standard at any time. 
 

6. When you are finished specifying the method parameters and 
selecting standards, choose OK. 

RESULT Integration starts the TQ Analyst method development 
application and displays the application’s main screen. 

 
 

7. Make sure the Analysis Type is set correctly for the type of method 
you want to create.  
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The following Analysis Type options are available in TQ Analyst.  

For quantitative analysis: 

• Simple Beer’s Law, which uses the classic Beer-Lambert-Bougher 
law (absorbance increases proportionally with concentration) to 
create a calibration model.  

• Classical Least Squares (CLS), which looks at many regions of the 
spectra to find relationships between absorbance and concentration.  

• Augmented Classical Least Squares (ACLS), which is a 
combination of the CLS and PCR techniques and it uses additional 
factors to facilitate method transfer. This option appears in the 
software only if you purchased the optional ACLS add-on for 
TQ Analyst software. See one of our sales representatives for more 
information.  

• Stepwise Multiple Linear Regression (SMLR), which expresses 
concentration as a function of the absorbance at specific 
frequencies.  

• Partial Least Squares (PLS), which uses a partial least squares 
statistical analysis to determine which spectral regions vary as a 
function of component concentration.  

• Principal Component Regression (PCR), which uses a principal 
component regression statistical analysis to determine which 
spectral regions vary with component concentration.  

For qualitative (classification) analysis: 

• Similarity Match, which uses multiple standards that define one 
class to determine how closely an unknown material matches a 
known material. Reports a match value, which indicates the quality 
of the match.  

• Distance Match, which uses multiple standards that define 
multiple classes to determine how closely an unknown material 
matches each class. Reports a list of classes ranked from best match 
to worst match, and a match value for each class.  
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• Discriminant Analysis, which uses multiple standards that define 
multiple classes to determine the class or classes of known materials 
which are most similar to an unknown material. Reports a list of 
classes ranked from best match to worst match, and a distance value 
for each class.  

• Search Standards, which uses multiple classes and one standard 
per class to determine which known material is most similar to an 
unknown material. Reports a list of standards ranked from best 
match to worst match, and a match value for each standard.  

• QC Compare Search, which uses multiple standards that define 
multiple classes to determine which standard and class is most 
similar to an unknown material. Reports the best matched standard 
in each class, and a match value for each standard. The classes are 
ranked from best match to worst match.  

For spectral measurements: 

• Measurement only, which measures the unknown sample 
spectrum and reports the measured value(s). You can specify up to 
50 measurements in a spectral measurement method. A spectral 
measurement method can be configured to do any of the following: 

Measure the height or area of a peak. 

Measure the ratio of two spectral peaks. 

Measure the random noise in a given region. 

Measure the width at half maximum of the largest peak in a region. 

Locate the largest peak in a specified region. 

Find where a peak is reduced to a specified percentage of its 
maximum height. 
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8. Select the Pathlength tab along the top of the window and make 
sure Pathlength Type is set correctly for the new method. 

 

Sample pathlength, defined as the distance a beam of incident energy 
travels within a sample, affects only quantitative and qualitative 
(classification) analyses. When analyzing samples that are in the solid 
state, sample pathlength is often referred to as “sample thickness.” The 
pathlength of a liquid sample is defined by the distance between the 
internal walls of the holder used to place the liquid in the light beam. 

If sample pathlength is constant, or assumed to be constant, set 
Pathlength Type to Constant. When the Constant pathlength option is 
selected, sample pathlength is not a factor in the analysis.  

If sample pathlength is variable or unknown, one of the other 
pathlength settings is appropriate. See your TQ Analyst User’s Guide for 
a general discussion of sample pathlength considerations for 
quantitative and qualitative measurements in spectral analysis 
applications. 

 Note If you are setting up a spectral measurement method, set Pathlength Type 
to Constant for no pathlength correction. If you want the method to 
calculate the ratio of two spectral peaks, set Pathlength Type to Peak Ratio 
and specify the denominator peak or region as the pathlength peak. See 
your TQ Analyst User’s Guide for more information about calculating peak 
ratios in a spectral measurement method.   
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9. If you are setting up a qualitative or quantitative method, select the 
Standards tab and make sure you imported the correct files for the 
standards. 

The titles of the standards that were imported from RESULT Integration 
software are listed in the standards table, as shown below.  

 

If you want to see the file names of the standards, select Show 
Spectrum File Names in the list of options that appears above the table. 
When Show Spectrum File Names is selected, the software expands the 
standards table to include a File Name column. 

The Usage column shows how the standards will be used in the 
method, as discussed in step 5 of this procedure. You may change the 
Usage setting for a standard at any time. 

 Note If you entered class names or concentration values for the standards, those 
characteristics will also be imported to TQ Analyst and reported in the 
Standards table.   
 

10. Select the Regions tab and specify the spectral region or regions 
that will be used for the analysis. 

If you are setting up a quantitative or qualitative (classification) 
method, the Regions wizard starts automatically. The initial screen 
displayed by the Regions wizard is shown below. 
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Choose Next in the wizard dialog boxes and then choose Finish to 
complete the wizard. TQ Analyst displays the Regions tab, as shown 
below. 

 

The end points of each spectral region that is currently selected for the 
analysis and the assigned “region type” are displayed in a table. To view 
the selected regions in a graphical display, choose Edit Regions. The 
software opens the Region Selection window, as shown below.  



 

Thermo Scientific RESULT Integration Software User Guide 125 

See your TQ Analyst User’s 
Guide for information about 

selecting regions for quantitative, 
qualitative, and spectral 

measurement methods, or choose 
the How To button in the 

Region Selection window to view 
the instructions on-line. 

 

Use the tools in the Region Selection window to make any adjustments 
to the selected regions, and the selected measurement type for each of 
those regions.  

 Note If you are setting up a spectral measurement method, you must select the 
peaks or regions to be measured manually using the tools in the Region 
Selection window. To display the Region Selection window, choose Edit 
Regions on the Regions tab. The software displays a Windows Open dialog 
box. Select the spectrum of a representative sample that will be analyzed 
with this method and then choose OK. The Region Selection window 
opens with the selected spectrum shown in the graphical display. Use the 
tools in the Region Selection window to select the peaks or regions to be 
measured and set the measurement type for each peak or region.  
 

11. When you are finished setting up the method, select the Calibrate 
button on the TQ Analyst toolbar to calibrate the method. 
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For quantitative and some qualitative methods, TQ Analyst uses the 
calibration step to analyze the method standards in order to calculate a 
method model. The model is then used to predict component 
concentrations or class similarities in unknown samples.  

 Note Spectral measurement methods and some classification methods do not 
require a method model. However, the software uses the “calibration” step 
to test the method for consistency and proper experimental design. If you 
neglect to calibrate a TQ Analyst method, the method will cause an error 
in your workflow when you test or run the workflow in RESULT software.  
 

12. Choose Save Method from the File menu to save the new method. 

Three files are created when you save a new TQ Analyst method. All 
three files will use the method file name you entered in step 4 above. 
The method specifications are saved in the file methodname.QNT. 
The spectral data for the method standards are stored in two associated 
library files (methodname.LBD and methodname.LBT). All three 
method files are saved in the same directory and path as the open 
workflow. 
 

13. Choose Exit from the File menu to quit TQ Analyst software. 

TQ Analyst closes and control is returned to RESULT Integration. The 
current workflow appears in the workflow navigation frame. 
 

14. If you configured the new method to be linked to a measure event 
in this workflow (see step 4 above), choose Save on the RESULT 
Integration toolbar to save the workflow.  

The TQ Analyst method files are now linked to the workflow. 
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Using third-party 
methods with RESULT 

RESULT supports add-in options for method development software 
applications from other software companies as well as our TQ Analyst 
method development software. The supported third-party applications 
include the following.  

• Thermo Scientific PLSplus/IQ method development software for 
GRAMS/32® AI. 

• The Unscrambler® method development software from Camo AS. 

• Pirouette method development software from InfoMetrix, Inc. 

 Note Please refer to the release notes for RESULT software (located on your 
Antaris Documentation disk) for information about the versions numbers 
for these software packages that are compatible with TQ Analyst and 
RESULT software.  

Read this section to learn how to create and save analytical methods that 
are compatible with RESULT using one of the third-party method 
development applications listed above. The chapter also demonstrates how 
to link a third-party method to a workflow created in RESULT Integration. 
After linking a third-party method to a RESULT workflow, you can save, 
test and run the workflow in RESULT Integration or RESULT Operation 
software the same way you do for workflows that are linked to methods 
created using TQ Analyst method development software.  
 

Before you begin Before you begin creating methods that will be linked to RESULT 
workflows, consider the following points: 

• Make sure the third-party method development application and any 
required run-time files are properly installed and configured on the 
computer you use to run RESULT. See Installing Your Software for more 
information. 

• Make sure the RESULT add-in option for your third-party method 
development software is installed on your computer. Use Instrument 
Status to determine whether the proper software components are 
installed. To view the instrument status report, choose Instrument 
Status from the Maintenance menu of RESULT Operation software. If 
you need to install an add-in option, see Installing Your Software for 
instructions.  
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• Workflows and their associated method files must be stored in the same 
directory or the workflows will not run. If a method has associated 
library or other run-time files, store those files in the same directory as 
the corresponding method. To determine which files are required to 
run a third-party method from another location or another software 
package such as RESULT, see the documentation that came with your 
third-party method development software.  

To locate workflows and methods, RESULT uses the directory and path 
specified in the Options dialog box in RESULT Integration software and 
in the RESULT Options dialog box in RESULT Operation software. To 
learn how to specify paths for storing workflows and methods in 
RESULT software, see ‘Setting RESULT Integration Options” in this 
manual and “Setting RESULT Operation Options” in the “RESULT 
Software Administration” manual. 

• When configuring and collecting standards for methods developed 
using third-party software, use the Configure Standards and Collect 
Standards commands in RESULT Integration or RESULT Operation 
software to configure and collect the method standards. In the 
Configure Standards dialog box, set the Sample Information feature on 
the Collect tab to “No Sample Prompt” and clear Require Digital 
Signature on the Save tab. Those features work only for methods 
developed using TQ Analyst software. You should also set the file 
format to Galactic (*.spc extension). Galactic is a binary file format that 
is compatible with The Unscrambler, PLSplus/IQ and Pirouette 
method development applications. See “Collecting Standards for 
Third-Party Methods” in the next section for more information.  

When you are finished collecting the methods standards, use the third-
party application to build your new method. (The Build TQ Analyst 
Method command in the RESULT Integration Tools menu works only 
for methods created using TQ Analyst software.)  

• You cannot use RESULT software to digitally sign methods created 
using third-party method development software. Only TQ Analyst 
method files can be signed from RESULT software.  
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• You may use a request event to set up a class-selection dialog box for 
qualitative (classification) methods created in TQ Analyst software (see 
“Request events” in “Workflow Events and Specifications” for more 
information). This feature is not available for methods created using 
third-party method development software.  
 

Collecting standards  
for third-party methods 

Before creating a new method for a RESULT workflow, create the basic 
workflow, including at least one collect event and a subsequent measure 
event, set up the collection parameters in the corresponding sample and 
background specifications, and then use the Configure Standards and 
Collect Standards commands in the RESULT Integration Tools menu to 
configure and collect the method standards.  

 Note Standards may also be run from RESULT Operation software using the 
Configure Standards and Collect Standards commands in the Standards 
menu. Before you are able to run standards in RESULT Operation, the 
RESULT administrator must give you the privilege to access the Standards 
menu.  

The Configure Standards dialog box allows you to define how the 
standards will be collected and archived. Use the Collect tab shown below 
to select the measure event(s) that requires standards.  
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See “Setting up the 
collection of standards” in 

this chapter for descriptions 
of the features in this dialog 

box. 

 

When configuring standards for methods developed using third-party 
software, set Sample Information to “No Sample Prompt” as shown above 
and use your third-party method development application to enter the 
sample titles and concentration values or class names. The sample 
information feature works only for methods developed using TQ Analyst 
method development software.  

Use the Save tab shown below to define the file format, path and base 
name for the new standards. 
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See “Setting up the archiving 
of standards” in this chapter 

for descriptions of the features 
in this dialog box. 

 
 

When configuring standards for methods developed using third-party 
software, follow these steps: 

• Set the file format to Galactic (*.spc extension). Galactic is a binary 
file format that is compatible with The Unscrambler, PLSplus/IQ, and 
Pirouette method development applications. 

• Clear Require Digital Signature. This feature works only for methods 
developed using TQ Analyst software.  

When you are ready to collect the standards, in the RESULT Integration 
main window open the Tools menu and then choose Collect Standards. 
The software displays the Run Time Test window, as shown below. 
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See “Testing a Workflow” in 
“Chapter 2 Creating and Editing 

Workflows” for descriptions of the 
features in the Run Time Test 

window. 

 
 

RESULT Integration collects standards based on how they were configured 
in the Configure Standards dialog box, along with the parameters specified 
in a collect and measure event in a workflow. See “Collecting Standards” in 
this chapter for more information. 
 

Building a third-party 
method for use with 

RESULT software 

After collecting the method standards, use your third-party software to 
build the new method. (The Build TQ Analyst Method command in the 
RESULT Integration Tools menu works only for methods created using 
TQ Analyst software.) When the method is completed, save it and then 
copy the method file and any other required run-time files to the directory 
and path for workflows and methods specified in the Options dialog box in 
RESULT Integration software or the RESULT Options dialog box in RESULT 
Operation software.  
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To determine which files are required to run a third-party method from 
another location or software package such as RESULT, see the 
documentation that came with your third-party method development 
software. For information about specifying paths for storing workflows and 
methods in RESULT software, see “Setting RESULT Integration Options” in 
this manual and “Setting RESULT Operation Options” in the “RESULT 
Software Administration” manual. 

 Note You must have the Unscrambler ON-LINE Classifier (OLUC) application 
installed on your computer to run an Unscrambler classification method 
from RESULT software and the Unscrambler ON-LINE Predictor (OLUP) 
application to run quantitative methods from RESULT. See Installing Your 
Software for more information.  

 Note You must have the full version of Pirouette software installed on your 
computer and Pirouette correctly configured for proper operation with 
RESULT. See Installing Your Software for more information.  
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Linking a third-party 
method to a RESULT 

workflow 

When creating workflows in RESULT Integration software, use a 
measurement specification to link your workflow to an existing third-party 
method. You can create a measurement specification two ways: from the 
Workflow tab (by choosing the New button at the right of the 
Measurement Specification list box) or from the Details tab (by selecting 
the Measure Specifications group and then choosing Add from the toolbar 
in the RESULT Integration main window). After you choose Add, the 
following dialog box appears.  
 

If you don’t see a measurement 
specification that matches your method 
development application, make sure the 

application and any required run-time 
files are properly installed and configured 
on the computer you use to run RESULT. 
In addition, check that the RESULT add-
in option for your method development 

software is installed. Use Instrument 
Status to determine whether the proper 

software components are installed. To 
view the instrument status report, choose 
Instrument Status from the Maintenance 
menu of RESULT Operation. If you need 

to install a run-time file or add-in option, 
see “Installing Your Software” for 

instructions. 

 
 

Select the template that matches the method development software 
application you used to create your analytical method. The software adds a 
new measurement specification for that software application to the 
workflow.  
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The following illustration shows a measurement specification for methods 
creating using The Unscrambler software.  
 

 
 

Use the File Name list box to select a method file to link to your workflow. 
Only methods created using the selected software application appear in the 
drop-down list. For example, when using the Unscrambler measurement 
specification, only Unscrambler methods appear in the drop-down list. (If 
your method doesn’t appear in the drop-down list, copy it to the directory 
and path listed above the File Name list box.)  
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After you select a method file, the measurement type and the RESULT 
component or other attribute names appear below the method file name, as 
shown below. 
 

 

Use the Test button on the RESULT Integration toolbar to test the new 
workflow. See “Testing a Workflow” in “Chapter 2 Creating and Editing 
Workflows” for more information.  

For each third-party method development software package and method 
type supported in RESULT, the following table lists each output variable 
and its corresponding RESULT attribute name. The attribute names appear 
in the Attribute list boxes throughout RESULT software so they can be 
added to logical test specifications, calculations, and sample reports in a 
workflow. 

Application 
Name 

Application 
Method Type 

Application Variable 
Name 

RESULT 
Attribute Name 

PLSplus/IQ PLS1 Concentration Concentration 

  Spectral F ratio 
(calculated) 

F-Ratio 

  Distance Mahalanobis 
distance 

 PLS2 Concentration Concentration 

  Spectral F ratio 
(calculated) 

F-Ratio 

  Distance Mahalanobis 
distance 
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Application 
Name 

Application 
Method Type 

Application Variable 
Name 

RESULT 
Attribute Name 

 PCR Concentration Concentration 

  Spectral F ratio 
(calculated) 

F-Ratio 

  Distance Mahalanobis 
distance 

 Discriminate Residual Concentration 

  Spectral F ratio 
(calculated) 

F-Ratio 

  Distance Mahalanobis 
distance 

Unscrambler PLS1 yPredicted Concentration 

  yDeviation Confidence value 

 PLS2 yPredicted Concentration 

  yDeviation Confidence value 

 PCR yPredicted Concentration 

  yDeviation Confidence value 

 PCA Si Concentration 

  Si/S0 Distance result 

Pirouette PLS Y Predictions Value 

  F Ratio F-Ratio 

  Mahalanobis Distance Mahalanobis 
distance 

 PCR yPredicted Value 

  F Ratio F-ratio 

  Mahalanobis Distance Mahalanobis 
distance 

 CLS Y Predictions Value 

  F Ratio F-ratio 

  Mahalanobis Distance Mahalanobis 
distance 

 KNN Predicted class Class name 

 SIMCA Class Distances Value 

  Predicted class Class name 
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Collecting data 

using Quick Collect 
The Quick Collect feature allows you to collect background and sample 
spectra without the necessity of creating or selecting a workflow. This is a 
helpful feature if you simply want to produce a viewable spectrum from a 
sample or background collection.  

To use the Quick Collect feature: 

1. Choose Quick Collect from the Tools menu in the RESULT 
Integration main window. 

The software opens the Run Time Test window, along with the Quick 
Collect dialog box, as shown below.  
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2. Select the sampling module you plan to use from the Sample Type 
drop-down list. 

The options in the drop-down list will vary, depending upon the 
instrument your software was configured to use. Once you select a 
sampling module, the Sample Parameters box will display the default 
settings for that module.  
 

3. Change any default settings in the Sample Parameters box. 

These parameters are described in the “Collect events,” “Sample 
Specifications,” and “Background Specifications” sections of 
“Workflow Events and Specifications.”  

Recommended settings for the collection parameters are also provided 
for each sampling module. See the appropriate section for your 
sampling module in your Antaris User’s Guide for more information. 

 Note When deciding what to select in the Operator Prompts drop-down list, the 
selection you make should depend on the sampling module you are using 
and whether you are collecting background data using an internal or 
external reference. See the appropriate section for your sampling module in 
your Antaris User’s Guide for more information about specifying operator 
prompts in the Quick Collect feature.   



 

140 RESULT Integration Software User Guide Thermo Scientific  

If you need to determine appropriate gain and attenuation settings for 
your samples, choose Optimize Gain in the Quick Collect dialog box. 
When you choose Optimize Gain, the following dialog box appears:  

For detailed information about the 
Optimize Gain feature, see “Sample 
specifications” in “Workflow Events 

and Specifications.” 

 

To determine the recommended gain and attenuation wheel settings 
for a sample material, prepare a representative sample for data 
collection, place the sample in the appropriate sampling module, and 
then choose Start Measure in the Optimize Gain dialog box. The 
software collects sample data using each possible combination of gain 
and attenuation settings to find the settings that produce the best 
results. When the measurements are completed, the results appear in a 
table in the Optimize Gain dialog box.  

If you want the software to automatically reset the Attenuator and Gain 
parameters in the Quick Collect dialog box to the recommended 
settings (or simply reset Gain to the highest voltage value), choose Use 
Selected Settings in the Optimize Gain dialog box. The dialog box 
closes and the new Gain setting appears in the Quick Collect dialog 
box.  
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4. If you are collecting a background spectrum only, select Collect 
Background Only. 

When this option is cleared, the software collects both a background 
and sample spectrum.  
 

5. If you want to collect multiple spectra from the same sample 
(recommended for samples that are not homogeneous), enter the 
number of collections you want to perform in the Number Of 
Repetitions text box. 

If Number Of Repetitions is greater than 1, then the Collect One 
Background feature will become available, as shown below. 

 

Select Collect One Background if you want to collect only one 
background spectrum for the experiment. If you want to collect a 
background spectrum for each sample collection, then do not select this 
check box. 

 Note If you use the option to collect multiple spectra, then those spectra will not 
be displayed until all of the repetitions are completed. If you elect to 
archive the spectral data and/or report from multiple collections, the 
spectra will be saved in separate data (*.spa) files and overlaid in a spectral 
plot in a report (*.htm) file.  
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6. If you want to specify custom X- and/or Y- axes for the spectral 
display, select the Use Custom X-axis Range For Spectral Display 
and/or the Use Custom Y-axis Range For Spectral Display check 
box(es). 

If you do not select custom axes, then the software will use the default 
spectral range and data format range (the data will be autoscaled). If 
you select one or both of the custom axis check boxes, then you need to 
enter the beginning and ending ranges in the appropriate entry boxes, 
as shown below. 

The Start and End entry boxes 
become available if you select one of 
the custom axes check boxes. Enter 

the starting and ending values in the 
appropriate entry boxes. 

 

 
7. Select any archive options. 

You can elect to archive a spectrum and/or report by selecting the 
appropriate check boxes. The Archive Spectral Data check box directs 
the software to save the spectrum as a spectral file (*.spa), which is 
compatible with many Thermo Scientific spectroscopy software 
packages, including RESULT Integration and TQ Analyst. Archive 
Reports directs the software to save the report as an HTML file 
(*.htm), which is viewable by Web browser applications and RESULT 
Integration and Operation software. If the report includes a spectrum, 
it also saves a bitmap image of the spectrum (*.png) in the same 
directory as the report. The bitmap image is required to properly 
display the report in RESULT software. If you open the report file and 
the bitmap image isn’t available, the report will have a blank box where 
the spectrum should be.  
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If you elect to archive the spectrum or report, then the Base Name box 
and Require Digital Signature check box become available, as shown 
below. 

 

The software automatically completes the Base Name box based on the 
type of module you are using. However, you can change this base name 
or delete it.  

If you use a base name, the files will be saved with that base name, plus 
a globally unique identifier (GUID) and the appropriate extension. If 
no base name is entered, the files will be archived using the GUID and 
the appropriate extension. 

You can also elect to digitally sign the archived item by selecting the 
Require Digital Signature check box. 
 

8. After you have selected the appropriate options, choose OK. 

The software closes the Quick Collect dialog box. If you close the 
dialog box without choosing OK, your settings will not be saved and 
collection will not begin. Choose Cancel to close the dialog box 
without saving your settings. 
 

9. Choose Go from the Run Time Test Window to begin collection. 

After you choose Go, the software begins data collection. If you are 
prompted to prepare for a background and/or sample collection, after 
you have prepared the appropriate items, choose OK at the software 
prompt to continue the collection process. 

When data collection is complete, the spectrum appears in the display 
area of the Run Time Test window. If you elected to archive the 
spectra and/or report files but did not require digital signatures, the 
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file(s) are automatically archived. Archived data produced using the 
Quick Collect feature of RESULT Integration are placed in a Quick 
Collect subdirectory, which is located in the current directory for 
archiving spectra and reports as specified in the RESULT Options dialog 
box. See “Setting RESULT Integration Options” in “Chapter 1 Getting 
Started” for information about specifying the directory for archiving 
spectra and reports. 

If you elected to archive items and require a digital signature, the 
software opens the Digital Signature dialog box, as shown below. 

 

Enter your Windows user name in the User Name box, and your 
password in the Password box. The user name and password must 
match your Windows user name and password exactly, including the 
letter case. 

Select the Authorship option from the Reason for Signature drop-down 
list, or enter another appropriate reason for the signature, and choose 
OK.  

The spectrum is given a unique file name based on the base name, if 
one exists, along with the date and time the spectrum was collected and 
a globally unique identifier (GUID). The file is stored in the location 
that was specified in the Configure Standards dialog box in the 
previous chapter. 

 Note You have three attempts to enter your password correctly when digitally 
signing a file. If you are unable to correctly enter your Windows password, 
or if you choose Cancel from the Digital Signature dialog box, the file will 
not be digitally signed. The software will create a report of workflow errors 
indicating that the file has not been signed.  
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Viewing Spectra The View Spectra feature in RESULT Integration software allows you to 
view a spectrum or spectra using the TQ Analyst software package. You can 
view spectral files that have been saved in one of the following formats: 

• Nicolet (*.spa), which is the standard format for spectra for use with 
Thermo Scientific spectroscopy applications, including RESULT 
Integration, RESULT Operation, and TQ Analyst. 

• JCAMP-DX (*.jdx), which is a file format that is compatible with 
other applications in the industry and includes only printable ASCII 
characters and some file header information.  

• Comma-Separated Values (*.csv), which is a text file that specifies 
each data point in the spectrum as a set of X and Y values. The values 
may be separated by a list separator (defined by the Windows regional 
settings) or a tab. CSV formatted files can be read by any compatible 
spreadsheet or other program.  

The View Spectra feature allows you to open a spectrum or group of 
spectra based on a file base name and/or date range. 

 Note In order to use the View Spectra feature, you must have TQ Analyst 
software installed on your system. TQ Analyst is included on your RESULT 
disk.  

To view a spectrum or spectra: 

1. Select View Spectra from the Tools menu in the main window of 
RESULT Integration software. 

The software opens the View Spectra dialog box, as shown below.  
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2. Enter the path where the spectrum or spectra are located in the 
Path text box. 

If the correct path does not already appear in the box, you can type the 
path in the text box, or choose Browse to open a standard Windows 
Browse dialog box.  

If you choose Browse, navigate to the correct path in the Browse dialog 
box, and then choose Select, as shown below.  

Spectral files do not 
appear in the Browse 

dialog box when choosing 
a directory path. 

 

The dialog box closes and the selected path appears in the Path box in 
the View Spectra dialog box. 
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3. Select the standards you want to view. 

Use the Base Name and Date Options features to select the standards.  

 

• Select All Files With Base Name. To select multiple standards that 
have the same base name, leave this check box selected. If you want 
to select a single standard or a group of standards that have unique 
file names, clear Select All Files With Base Name. 

• Base Name. If the file names of all the standards have the same 
base name, you can use the base name feature to quickly select 
those standards. Make sure Select All Files With Base Name is 
selected (see above) and then enter the base name in the Base Name 
box, or choose Browse to search for a representative standard. After 
you select a standard, its base name appears in the Base Name box 
in the View spectra dialog box. The software will select all the 
standards that have the specified base name and are located in the 
specified directory and path, or use Date Options to limit those 
standards.  

 Note Using a base name to select the spectra to view can cause a delay if you have 
many spectra with the same base name.   

If you want to select a single standard, make sure Select All Files 
With Base Name (see above) is cleared and then use the Base Name 
box to specify the standard. You can type the file name of the 
standard in the Base Name box or choose Browse to search for the 
standard. After you choose Browse, the software opens a standard 
Windows Open dialog box that points to the appropriate path, and 
you can select the standard. After you select the standard, its file 
name appears in the Base Name box in the View spectra dialog box. 
The software will select only that standard.  
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If you want to select a group of standards that have unique file 
names, make sure they are located in the specified path and leave 
the Base Name box blank. The software will select all the standards 
located in the specified directory and path or use Date Options to 
limit those standards. 

• Date Options. Use the Date Options to broaden or limit the 
selected standards. Leave the default setting (All Dates) to select all 
standards that have the specified base name, if one was entered, and 
are located in the specified directory and path. If you want to limit 
the selected standards to include only those files which were 
collected on a certain day or time, or in a date or time range, set the 
date or time option by selecting an item in the Date Options drop-
down list. Depending on the selection you make, the Starting Date 
and/or Ending Date boxes may become available. You can change 
the dates in these boxes by: 

- Typing the appropriate dates(s) in the boxes; 

- Selecting a portion of the date and using the arrow keys on your 
keyboard to adjust the date; or 

- Selecting the drop-down arrow to the right of the box. If you select 
the drop-down arrow on one of the date boxes, the software opens 
a calendar, as shown below. 

 

Choose the date from the calendar with your cursor. Use the arrow 
buttons at the top of the calendar to navigate to the next and 
previous months.  
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You can change the time by typing the appropriate time in the box, 
or by selecting a portion of the time and using the arrow keys on 
your keyboard or the Up and Down buttons to the right of the box 
to change the time. 
 

4. Use the Date Options to broaden or limit the selected spectra. 

Leave the default setting (All Dates) for Date Options to select all 
spectra that have the specified base name, if one was entered, and are 
located in the specified directory and path.  

If you want to limit the selected spectra to include only those files 
which were collected on a certain day or time, or in a date or time 
range, set the date or time option by selecting an item in the Date 
Options drop-down list.  

Depending on the selection you make, the Starting Date and/or 
Ending Date boxes may become available. You can change the dates in 
these boxes by: 

• Typing the appropriate dates(s) to the boxes; 

• Selecting a portion of the date and using the arrow keys on your 
keyboard to adjust the date; or 

• Selecting the drop-down arrow to the right of the box. If you select 
the drop-down arrow on one of the date boxes, the software opens 
a calendar, as shown below. 
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Choose the date from the calendar with your cursor. Use the arrow 
buttons at the top of the calendar to navigate to the next and 
previous months. 

You can change the time by typing the appropriate time in the box, 
or by selecting a portion of the time and using the arrow keys on 
your keyboard or the Up and Down buttons to the right of the box 
to change the time. 
 

5. Choose OK to view the spectrum or spectra you have specified. 

The software closes the View Spectra dialog box and opens 
TQ Analyst. Depending upon the number of spectra you have chosen 
to view, it may take several minutes for the software to load the spectra 
into TQ Analyst. 

Once the software has finished loading the spectra, you can view each 
spectrum by selecting it from the drop-down list, as shown below. 
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See your TQ Analyst documentation for information about working 
with the features in the spectral window. 
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Chapter 5 System Maintenance 

The Maintenance menu in RESULT Integration contains diagnostics and 
other features to assist you with troubleshooting and maintenance of the 
system. The features in the maintenance menu include: 

• Test Sample, which allows you to perform a diagnostic run of a sample 
collection event in a workflow.  

• Test Background, which allows you to perform a diagnostic run of a 
background collection event in a workflow. 

• Test Measurement, which allows you to perform a diagnostic run of a 
measurement event in a workflow.  

• Instrument Status, which produces a report of the status of the laser, 
source, detectors, and power supply. The instrument status report also 
contains serial numbers and firmware version information. 

• Align Instrument, which calibrates the gain, aligns the laser, and 
optimizes the interferogram position for the instrument. 

• Instrument Check, which uses the main analyzer transmission detector 
to produce a series of spectra for diagnostic purposes. The spectra 
produced by running the instrument check include an interferogram, a 
single-beam, 100% line, and polystyrene (if the system has an internal 
attenuator wheel that includes a polystyrene sample). 

All of these features are also available in the Maintenance menu of RESULT 
Operation. For detailed information about using a maintenance feature, see 
the feature name in “System Maintenance” in the RESULT Operation User 
Guide.  
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Chapter 6 Troubleshooting RESULT 

Integration 

This chapter describes some possible problems you may encounter when 
developing and testing workflows in RESULT Integration software and 
offers some suggestions for resolving them.  

If you are unable to resolve a problem or have questions or concerns, call 
one of our service representatives or use the information at the beginning of 
this document to contact us.  

 Notes The information in this chapter pertains to troubleshooting issues within 
RESULT Integration software only. Troubleshooting information can also 
be found in other sections of this user’s guide pertaining to RESULT 
Operation software, software administration, and sampling modules. 
 
Updated troubleshooting information can also be found in the release notes 
issued for the software on your installation disks. 
 
Because they are self-explanatory and contain suggestions for resolution, 
workflow errors are not covered in this troubleshooting chapter. If you 
receive workflow errors when testing a workflow, follow the suggestions in 
the error table for resolving the situation. 
 
When testing workflows, additional troubleshooting information may be 
found in the troubleshooting chapter in “RESULT Operation Software,” 
since the test mimics how the workflow will be run in RESULT Operation 
software.  
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Logging on to the workstation/software 

Problem Possible Causes Suggestions 

A Service Control 
Manager message appears 
when you log on to the 
workstation, stating that 
at least one service or 
driver failed during 
startup. 

The analyzer is not 
connected to the 
workstation. 

If an analyzer is supposed to be connected to the 
computer, make sure the instrument is properly 
connected to the computer. Log off the computer 
and restart before running any workflows. 

If an analyzer is not supposed to be connected to 
the computer (if the computer is for software use 
only), then you do not need to perform any action 
in order to use the software. However, you may 
want to have your Windows administrator reinstall 
the software without loading the bench driver to 
avoid receiving this message each time you log on 
to the workstation. 

 

Using the Workflow wizard 

Problem Possible Causes Suggestions 

The sampling module you 
want to use does not 
appear in the Sample 
Specification drop-down 
list. 

The instrument model is 
specified incorrectly in 
the software’s options. 

Choose Options from the Edit menu. In the 
Target Instrument Options, make sure the proper 
model is selected from the Model drop-down list. 

The Validation Wheel 
Sample option does not 
appear in the Sample 
Specification drop-down 
list. 

The software was not set 
up to develop customer 
qualification workflows. 

Choose Options from the Edit menu in RESULT 
Integration software. Make sure the Instrument 
Has ValPro Option Installed check box is selected 
in the Target Instrument Options. 

Note:  Your system must have the ValPro System 
Qualification software package and the internal 
validation wheel in order to develop customer 
qualification workflows. 
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Problem Possible Causes Suggestions 

The TQ Analyst method 
does not appear in the TQ 
Analyst method drop-
down list. 

The method file is not 
stored in the directory 
specified for locating 
workflows and methods. 

Choose Options from the Edit menu. Make sure 
the directory path for locating workflows and 
methods points to the file where the method is 
stored. 

-or- 

Locate the method file and move it into the 
directory for storing workflows and methods as 
shown in the software’s options. 

 

Developing workflows 

Note Events and specifications are dependent on each other and must be developed and appear in the proper 
order to work effectively. See “Workflow Events and Specifications” for specific information about how a 
particular event or specification is dependent on and related to other events and specifications.  

 Normally, if an item does not appear in a drop-down list when working with an event or specification, a 
related event or specification has not yet been created. See the section specifically describing the event or 
specification for more information about items related to them.  

 
Problem Possible Causes Suggestions 

You receive an error 
message stating, “Invalid 
Setting. Please Check 
Required Fields.” 

A required field in the 
software is not 
completed. Usually, the 
required field is the text 
box containing the title 
of the event or 
specification. 

Enter the name of the event or specification in the 
appropriate text box. If the name already appears, 
check other text boxes in the software window to 
determine which required field needs to be 
completed before progressing further. 
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Problem Possible Causes Suggestions 

Specifications are no 
longer linked to events. 

When using copy & 
paste features to paste 
items from a workflow in 
one session of RESULT 
Integration into a 
workflow in another 
session of the software, 
specifications do not stay 
linked to workflow 
events. 

Go into each workflow event and attach the 
appropriate specifications. 

Specifications do not 
appear in workflow events 
that you have copied from 
one workflow into 
another. 

When using copy & 
paste features to paste 
items from a workflow in 
one session of RESULT 
Integration into a 
workflow in another 
session of the software, 
linked specifications are 
not copied along with 
events. 

Go into the Details tab, copy the appropriate 
specification(s), and paste them into the new 
workflow. 

The Validation Wheel 
Sample option does not 
appear in the New 
Specification dialog box. 

The software was not set 
up to develop customer 
qualification workflows. 

Select Options from the Edit menu in RESULT 
Integration software. Make sure the Instrument 
Has ValPro Option Installed check box is selected 
in the Target Instrument Options. 

Note:  Your system must have the ValPro System 
Qualification software package and the internal 
validation wheel in order to develop customer 
qualification workflows. 
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Problem Possible Causes Suggestions 

You are unable to attach a 
spectrum to use as a 
simulated sample in a 
Sample Specification. 

The spectrum’s collection 
parameters do not match 
the workflow parameters. 

-or- 

The spectrum does not 
have an associated 
background spectrum. 

A spectrum for simulation must have been taken 
using the same parameters as specified in the 
workflow in RESULT Integration (except for the 
Number Of Sample Scans parameter). 

Collect a spectrum by running the actual workflow 
and using the intended sample material. Be sure 
the workflow is set up to archive the spectrum. 
After running the workflow, choose the archived 
spectrum to use for simulated data for future 
workflow tests. 

-or- 

Collect a spectrum using the intended sample 
material through the Samples for Simulation in 
the Sample Specification. Choose the New button 
to open the Collect New Spectrum From Analyzer 
dialog box. When the sample material is properly 
positioned, choose the Collect button to begin 
collecting the spectrum (make sure to leave the 
Collect Associated Background Spectrum check 
box selected). The sample spectrum you collect 
can then be used as simulated data for future 
workflow tests. 

The method name does 
not appear in the File 
Name drop-down list in 
the Measurement 
Specification. 

The method is not stored 
in the directory specified 
in the software for 
locating workflows and 
methods. 

Copy the method file into the appropriate 
directory for locating workflows and methods (this 
information can be found in RESULT Integration 
options). 

 The directory path for 
storing workflows and 
methods is incorrect. 

Choose Options from the Edit menu, and change 
the path for locating workflows and methods to 
the appropriate directory. 
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Problem Possible Causes Suggestions 

The name of an image file 
does not appear in the 
Select An Image text box 
(in the Add/Edit Header 
Item dialog box when 
adding a heading section 
to a report) after you have 
chosen to display a custom 
image from the Select 
Data Type drop-down 
list. 

The image is not stored 
in the directory specified 
in the software for 
locating HTML images. 

Copy the image file into the appropriate directory 
for locating HTML images (this information can 
be found in RESULT Integration options). 

 The directory path for 
locating HTML images is 
incorrect. 

Choose Options from the Edit menu, and change 
the path for locating HTML images to the 
appropriate directory. 

Images do not appear in 
reports. 

The image is not located 
in the same directory as 
the report. 

Copy the image file into the same directory as the 
report.  

 The image format is not 
supported by your web 
browser. 

Using another graphic program, save the image in 
a format that is supported by your web browser, 
such as *.jpg, *.gif, *.bmp, or *.png. 

When testing a workflow, 
you receive a message 
stating “Too many bad 
scans occurred, so 
collection was aborted.” 

The gain setting is too 
high, and you are 
collecting multiple 
samples with only one 
background collection. 

In the Sample Specification, lower the Gain to 1x 
or 2x. 

-or- 

In the Collect Event, change the Background 
Frequency to collect Before Every Sample. 

When testing a workflow, 
you receive a workflow 
error stating, 
“Interferogram peak 
location not found within 
expected range. An 
alignment of the 
instrument may be 
necessary.” 

If aligning the instrument 
does not solve the 
problem, the gain setting 
is too high and you are 
collecting multiple 
samples with only one 
background collection. 

In the Sample Specification, lower the Gain to 1x 
or 2x. 

-or- 

In the Collect Event, change the Background 
Frequency to collect Before Every Sample. 
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Digitally signing files 

Problem Possible Causes Suggestions 

The software is unable to 
recognize the password 
you entered when digitally 
signing a file. 

The letter case of your 
password does not match 
your password stored on 
the computer. 

Make sure you type the password correctly, 
including matching letter case (for example, all 
capital letters, all lower case letters, or a mixture of 
capital and lower case letters). Be sure the Caps 
Lock key is not turned on. 

 Another user is logged 
into the workstation. 

Close the software and point to Shut Down from 
the Start menu on the Windows Taskbar. Select 
the Close All Programs And Log On As A 
Different User Option, and choose OK. Log onto 
the workstation using your user name and 
password. 

 Your password has been 
changed or forgotten 

See your Windows administrator to reset your 
password. 

You receive other types of 
errors when attempting to 
digitally sign a file. 

Windows Workstation 
files are missing or were 
overwritten with different 
versions when installing 
other software 
applications. 

Have a Windows administrator install or reinstall 
the latest Windows Service Pack. 
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Building a TQ Analyst method 

Note If you experience other problems with building methods than the ones described below, or if any of the 
below suggestions do not help resolve the problem you are experiencing, refer to your TQ Analyst 
documentation for more assistance with building methods.  

 
Problem Possible Causes Suggestions 

You receive an error 
message: Failed to read the 
selected method. 

The TQ Analyst method 
has not been created. 

When using the Build TQ Analyst Method dialog 
box, make sure to select the Create TQ Analyst 
Method check box and enter a name for the 
method in the File Name text box. 

You cannot add standards 
to your method. 

The method is a 
measurement only 
method type. 

Standards are not required for a measurement only 
method type. Double-check the method type to 
make sure you have selected the correct type. 

 

Viewing spectra 

Problem Possible Causes Suggestions 

The process of opening 
TQ Analyst to view 
spectra is taking too long, 
or the feature stopped 
working before all spectra 
were opened. 

Too many spectra have 
been selected to be 
viewed. 

Reduce the number of spectra you are opening 
with this feature. You can do this by clearing the 
Automatically Remove GUID From File Name 
check box in the View Spectra dialog box. 
Clearing this check box will allow you to open 
only the spectrum you select (as opposed to all 
spectra that contain the same file base name). 
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Configuring and collecting standards 

Problem Possible Causes Suggestions 

While configuring 
standards, you receive a 
message stating that the 
workflow does not contain 
any measure events. 

The appropriate 
workflow is not loaded in 
the software. 

Select and load the appropriate workflow. 

 The workflow does not 
contain a measure event. 

Add a measure event to the workflow. 

 

Running Quick Collect 

Problem Possible Causes Suggestions 

You receive a message 
stating “Too many bad 
scans occurred, so 
collection was aborted.” 

The gain setting is too 
high, and you are 
collecting multiple 
samples with only one 
background collection. 

Lower the Gain to 1x or 2x. 

-or- 

Clear the Collect One Background only check box 
so the software will collect a background spectrum 
for each repetition of the experiment. 

You receive a message 
stating, “Interferogram 
peak location not found 
within expected range. An 
alignment of the 
instrument may be 
necessary.” 

If aligning the instrument 
does not solve the 
problem, the gain setting 
is too high and you are 
collecting multiple 
samples with only one 
background collection. 

Lower the Gain to 1x or 2x. 

-or- 

Clear the Collect One Background only check box 
so the software will collect a background spectrum 
for each repetition of the experiment. 

 



 

162 RESULT Integration Software User Guide Thermo Scientific  

Index 

A 
accessibility 

changing display colors, 24 
hot keys, 21 
shortcut menus, 23 

ACLS methods, 120 
Add button (toolbar), 11 
Add Event dialog box, 42 
Add Specification command, 50 
Add Specification dialog box, 50 
analysis types, 120 
analytical method. See also method 
analytical methods 

building with third-party software, 127, 132 
building with TQ Analyst software, 113 
restrictions for locating, 6 

analyzer model 
specifying in RESULT Integration software, 7 

Antaris Multiplexer 
adding a sampling sequence to workflows, 54 

archive 
path for storing RESULT Integration data, 4 

archiving 
setting a directory path for in RESULT Integration software, 

4 
attenuator wheel 

viewing attenuator information in Result Integration, 152 
Augmented Classical Least Squares (ACLS) methods, 120 
autosampler workflows 

adding a sampling sequence, 54 

 
B 
Back button, 12, 67 
Back command, 67 
backgrounds 

collecting with Quick Collect in RESULT Integration, 138 
for RESULT Integration software 

test collections, 152 
setting a directory path for archiving in RESULT Integration, 

4 
base name error, 43 
base names 

for spectral files, 147 

for standards, 107 
for workflow events, 42 

base path 
setting for archived spectra and reports, 5 

Build TQ Analyst Method command, 114 
buttons 

for RESULT Integration software 
Add, 11 
Back, 12, 67 
Collapse, 12 
Expand, 12 
Forward, 12, 67 
New, 11 
Open, 11 
Page Setup, 79 
Print, 79 
Reset, 12, 70 
Save, 11 
Test, 11 
Wizard, 11 

 
C 
CFR 21 compliance, 81 
charts 

displayed during sequence data collection, 77 
Check Signature command, 85 
checking instruments, 152 
class names 

importing to TQ Analyst, 123 
Classical Least Squares (CLS) methods, 120 
classification methods, calibrating, 126 
Clear command, 69 
clipboard 

copying workflow items, 67 
pasting workflow items, 68 

closing 
RESULT Integration software, 24 

CLS methods, 120 
Code of Federal Regulations 

digital signature compliance, 81 
Collapse button, 12 
Collect Background Only parameter 

for Quick Collect in Result Integration, 141 
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Collect Standards command, 109 
collecting 

samples and backgrounds using Quick Collect, 138 
standards for method development, 108 
test collections, 152 

collecting data 
using a workflow, 71 

collection 
specifying in the Workflow wizard, 28 

commands 
choosing in RESULT Integration, 10 
in RESULT Integration software 

Add Event, 41 
Add Specification, 50 
Back, 67 
Build TQ Analyst Method, 114 
Check Signature, 85 
Clear, 69 
Collect Standards, 109 
Configure Standards, 97 
Copy, 67 
Cut, 67 
Exit, 24 
Export, 90 
Forward, 67 
New Workflow, 36 
Open Workflow, 38 
Options, 5 
Paste, 68 
Print, 79 
Quick Collect, 138 
Redo, 70 
Reset, 70 
Save Workflow As, 80 
Test Workflow, 71 
Undo, 70 
View Spectra, 145 
Workflow Wizard, 28 

comma-separated values (CSV) file format, 104, 145 
components 

checking specifications in Result Integration, 152 
concentration curves 

displayed during sequence data collection, 77 
concentration values 

importing to TQ Analyst, 123 
Configure Standards command, 97 
Configure Standards parameter 

restrictions for using, 97 
configuring 

directory paths, 4 

instrument settings, 4 
standards for method development, 96 
third-party methods, 127 
TQ Analyst methods, 113 

Copy command, 67 
copying 

workflow items, 67 
creating 

a sampling sequence from a text file, 60 
a sampling sequence from a workflow, 55 

CSV file format, 104, 145 
Curves tab, described, 77 
curves, concentration 

displayed during sequence data collection, 77 
custom images 

default directory, 6 
Cut command, 67 
cutting workflow items, 67 

 
D 
data 

collecting using Quick Collect, 138 
specifying collection with Workflow wizard, 28 
data archive 
specifying with the Workflow wizard, 32 
data collection 
specifying in the Workflow wizard, 28 
date ranges 
setting for viewing spectra, 149 
default settings for workflow parameters 
restoring, 70 

deleting 
items in workflows, 69 

Details tab, 15 
adding specifications with, 49 

detectors 
viewing detector information in Result Integration, 152 

diagnostics 
for RESULT software, 152 
Instrument Status feature, 152 
test collections of samples, backgrounds, or measure events, 

152 
dialog boxes 

in RESULT Integration software 
Add Event, 42 
Add Specification, 50 
Build TQ Analyst Method, 114 
Digital Signature, 82 
Export Files, 90 
Open, 38 
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Options, 5 
Quick Collect, 138 
Save As, 80 
Select Test Case, 74 
View Spectra, 145 
Workflow Wizard, 28 

Digital Signature dialog box, 82 
digital signatures 

checking in files, 85 
compliance with CFR, 81 
errors when signing files, 84 
file types that may be signed, 82 
restrictions with third-party methods, 128, 131 
signing workflow files, 81 
specifying reason for signature, 83 
specifying with the Workflow wizard, 32 

directory path settings 
for RESULT Integration software, 4 
RESULT Integration and RESULT Operation compared, 4 

Discriminant Analysis methods, 121 
display area 

in RESULT Integration software, 16 
display colors 

changing, 24 
Distance Match methods, 120 
double signatures, 84 
drag and drop features for workflows 

restrictions, 66 

 
E 
Edit menu, 10 
editing 

a sampling sequence from a text file, 60 
a sampling sequence from a workflow, 55 

editing workflows, 65 
edits 

undoing and redoing in RESULT Integration software, 70 
error messages 

Authentication Failed, 84 
Base Name Error, 43 
Incorrect Password, 105 

errors. See also workflow errors 
resolving for workflows, 79 
when digitally signing files, 84 

events 
base names, 42 
executing one at a time while testing workflows, 78 
restrictions for editing names, 65 

example workflows, 25 
instructions for running, 26 

running with simulated spectra, 25 
Execute One Event At A Time parameter, 73 
Exit command, 24 
Expand button, 12 
Export command, 90 
exporting 

a sampling sequence to a text file, 63 
workflow simulation spectra, 93 
workflows, 91 

 
F 
fail image, default directory, 4 
file formats 

Comma-Separated Values (*.CSV), 145 
for archived standards, 104 
JCAMP-DX (*.JDX), 145 
Nicolet (*.SPA), 145 

File menu, 10 
file names 

for exported workflow simulation spectra, 95 
for exported workflows, 93 
for TQ Analyst method files, 126 
for TQ Analyst method library files, 126 
for workflows, 34 

files 
checking for digital signatures, 85 
exporting, 91 
locating and storing, 4 
signing workflow files digitally, 81 
that can be digitally signed, 82 

firmware, viewing version information in Result Integration, 
152 

formats 
for archived standards, 104 

Forward button, 12, 67 
Forward command, 67 

 
G 
Galactic file format, 104 

requirement for third-party method development, 128 
GUID 

used to name standards, 107 

 
H 
Help menu, 10 
hot keys, 21 
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HTML images 
setting a directory path for locating in RESULT Integration, 

4 

 
I 
image files 

default directory, 4 
storing, 88 

importing 
a sampling sequence from a text file, 61 
standards to TQ Analyst methods, 115 

instructions 
creating, 86 
for running example workflows, 26 

instructions files 
storing, 89 

instrument 
aligning in Result Integration, 152 

Instrument Check feature 
running an instrument check, 152 

instrument model 
specifying in RESULT Integration software, 7 

instrument options, 4 
instrument serial numbers, viewing in Result Integration, 152 
Instrument Status feature 

in Result Integration, 152 

 
J 
JCAMP-DX (*.JDX) file format, 145 
JCAMP-DX file format, 104 

 
K 
keyboard interactions 

in RESULT Integration software, 22 

 
L 
laser 

aligning, 152 
logging on 

to workstations, 3 

 
M 
maintenance 

aligning the instruments, 152 
running an instrument check, 152 

Maintenance menu 
in Result Integration, 152 

measure events 
for RESULT Integration software 

test collections, 152 
Measurement Only methods, 121 
menu bar 

for RESULT Integration software, 10 
menu commands 

in RESULT Integration software, 10 
menus 

for RESULT Integration software 
Edit, 10 
File, 10 
Help, 10 
Maintenance, 152 
Tools, 10, 96 

method development software 
building a method using third-party software, 127, 132 
building a method using TQ Analyst, 113 
collecting standards for method development, 108 
configuring standards for method development, 96 

method files 
for third-party methods 

storing, 128 
for TQ Analyst methods, 126 

storing, 88 
method model 

for spectral measurement methods, 126 
methods 

analysis types, 120 
building with third-party software, 127, 128, 132 
building with TQ Analyst software, 113 
linking third-party methods to workflows in RESULT 

Integration, 134 
restrictions for locating, 6 
setting a directory path for locating in RESULT Integration 

software, 4 
model 

for spectral measurement methods, 126 
specifying instrument model in RESULT Integration, 7 

multiple signatures, 84 
Multiplexer workflows 

adding a sampling sequence, 54 

 
N 
navigating between screens in a workflow, 67 
navigation frames 

workflow navigation frame, 12 
New button, 11 
New Workflow command, 36 
Nicolet file format, 104, 145 
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O 
off-line production mode 

reports generated in, 79 
Open button, 11 
Open dialog box, 38 
Open Workflow command, 38 
operator prompts 

specifying collection prompts using Quick Collect, 139 
specifying collection prompts with Workflow wizard, 30 

options 
for RESULT Integration software, 4 
for third-party method development software, 127 
RESULT Integration and RESULT Operation compared, 4 

Options command, 5 

 
P 
parameters 

in RESULT Integration software 
Execute One Event At A Time, 73 
Run Continuously, 73 
Text Size, 73 
Use Simulated Data, 73 

Partial Least Squares (PLS) methods, 120 
pass/fail images 

default directory, 4 
passwords 

for logging onto workstations, 3 
restrictions for choosing, 81 
specifications for, 83 

Paste command, 68 
pasting workflow items, 68 
pathlength, 122 
paths 

for archiving data in RESULT Integration software, 4 
for locating workflows and methods in RESULT Integration 

software, 4 
PCR methods, 120 
PDF documents 

creating, 86 
signing, 87 

peaks, ratioing, 122 
PLS methods, 120 
pressure 

and running standards for method development, 98 
Principle Component Regression (PCR) methods, 120 
printing 

from RESULT Integration display area, 23 
sample reports automatically from workflows, 32 

production mode 
off-line, 79 

prompts 
displayed in workflows, 75 
for user name and password, 83 

 
Q 
QC Compare Search methods, 121 
qualitative analysis 

defining regions, 123 
Discriminant Analysis methods, 121 
Distance Match methods, 120 
importing standards collect in RESULT, 115 
QC Compare Search methods, 121 
saving a new method, 126 
Search Standards methods, 121 
setting Pathlength Type, 122 
Similarity Match methods, 120 

quantitative analysis 
Augmented Classical Least Squares methods, 120 
Classical Least Squares methods, 120 
defining regions, 123 
importing standards collect in RESULT, 115 
Partial Least Squares methods, 120 
Principle Component Regression methods, 120 
saving a new method, 126 
setting Pathlength Type, 122 
Simple Beer’s Law methods, 120 
Stepwise Multiple Linear Regression methods, 120 

Quick Collect command 
for RESULT Integration software, 138 

collecting backgrounds, 141 
specifying operator prompts, 139 

quitting 
RESULT Integration software, 24 

 
R 
range 

for X or Y axis of displayed spectra, 142 
ratioing 

regions, 122 
Redo command, 70 
redoing edits in workflows, 70 
regions 

ratioing, 122 
selecting for spectral measurement methods, 125 

Regions tab in TQ Analyst method development software, 124 
repeat events 

adding a sampling sequence to, 53 
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reports. See also sample reports 
changing displayed text size, 73 
creating with the Workflow wizard, 31 
displayed in Result Integration software, 78 
generated from simulated data, 79 
generated in diagnostic mode, 79 
generated in off-line production mode, 79 
printing manually, 79 
setting a directory path for archiving in RESULT Integration, 

4 
Reset button, 12 
Reset command, 70 
RESULT add-in options 

for third-party method development software, 127 
RESULT Integration software 

Instrument Check feature, 152 
Instrument Status feature, 152 

RESULT Integration software 
adding a sampling sequence to workflows, 52 
adding linked specifications to workflow events, 44 
adding specifications to workflows, 43 
adding unlinked specifications to workflows, 49 
arranging events in workflows, 65 
building analytical methods with third-party software, 127, 

132 
building analytical methods with TQ Analyst, 113 
checking digital signatures, 85 
collecting data 

using Quick Collect, 138 
copying workflow items, 67 
creating workflows 

using the New Workflow command, 35 
using the Open Workflow command, 38 
using the workflow wizard, 26 

cutting workflow items, 67 
deleting workflow items, 69 
drag and drop features for workflows 

restrictions, 66 
editing workflows, 65 
executing events one at a time while testing workflows, 78 
exporting workflow files, 89 
hot keys, 21 
interacting via the keyboard, 22 
linking specifications to workflow events, 48 
logging onto workstations, 3 
main window, 9 

Details tab, 15, 49 
display area, 16 
resizing, 9 
workflow navigation frame, 12 

Workflow tab, 13 
menu bar, 10 
navigating between workflow screens, 67 
New Workflow command, 36 
Open Workflow command, 38 
option settings compared with RESULT Operation, 4 
pasting workflow items, 68 
printing displayed reports, 23 
Quick Collect feature, 138 
quitting, 24 
resetting workflow parameters to defaults, 70 
Run Time Test window 

Curves tab, 77 
Sequence tab, 76 
Spectra tab, 75 
Text tab, 77 

running workflows, 71 
sampling sequence prompt, 75 
saving workflows, 80 
setting directory paths, 4 
setting instrument options, 4 
setting options, 4 
shortcut menus, 23 
signing workflow files digitally, 81 
standards 

collecting, 108 
configuring, 96 

starting, 3 
starting new workflows, 26 
testing workflows, 71 
title bar, 10 
toolbar, 11 
transferring workflows to RESULT Operation, 87 
troubleshooting, 153 
undoing and redoing edits, 70 
viewing sequence data while running workflows, 76 
viewing spectra while running workflows, 75 
viewing spectra with TQ Analyst software, 145 
workflow errors, 79 
Workflow wizard, 28 

RESULT Operation software 
instrument alignment, 152 
transferring workflows from RESULT Integration, 87 

RESULT software 
diagnostics, 152 

run charts 
displayed during sequence data collection, 77 

Run Continuously parameter, 73 
Run Time Test window, 72 

Curves tab, 77 
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Execute One Event At A Time option, 73 
Sequence tab, 76 
Spectra tab, 75 
Text tab, 77 
used for collecting standards, 109 

running workflows 
in RESULT Integration software, 71 

 
S 
sample reports. See also reports 

changing displayed text size, 73 
creating using the Workflow wizard, 31 
displayed in RESULT Integration software, 78 
generated from simulated data, 79 
printing manually, 79 
setting directory path for archiving in RESULT Integration, 4 

sample titles 
used to name standards, 106 

sampling 
with RESULT Integration 

using Quick Collect, 138 
with RESULT Integration software 

test collections, 152 
sampling sequence 

adding to a workflow, 52 
creating from a text file, 60 
creating from a workflow, 55 
exporting, 63 
for autosampler workflows, 54 
for multiplexer module workflows, 54 
importing, 61 
operator prompt in workflows in RESULT Integration, 75 
used for collecting standards, 102 

Save As dialog box, 80 
Save button, 11 
Save Workflow As command, 80 
saving workflows, 80 
Search Standards methods, 121 
Select Test Case dialog box, 74 
sequence concentration values 

displayed during data collection, 77 
displayed in run charts during data collection, 77 

sequence data 
viewing while running workflows in RESULT Integration 

software, 76 
sequence module 

displaying concentration values during collection, 77 
displaying run charts during collection, 77 

Sequence tab 
described, 76 

sequence, sampling 
adding to workflows, 52 

serial numbers 
viewing in Result Integration, 152 

settings 
configuring for instrument, 4 
RESULT Integration and RESULT Operation compared, 4 
RESULT Integration options, 4 

shortcut menus 
in RESULT Integration software, 23 

signatures 
checking in workflow files, 85 

signing a file 
multiple times, 84 

Similarity Match, 113, 120 
Simple Beer's Law, 120 
simulated data 

running workflows with, 73 
sample reports produced from, 79 

simulation files 
storing, 89 

simulation spectra 
exporting, 93 

SMLR analysis type, 120 
SPA file format, 145 
specification groups, 15 
specification trees, 14 

expanding, 15 
specifications 

accessing for open workflows, 18 
adding from the Details tab, 49 
adding to workflows, 43, 49 
automatically linking to workflow events, 44 
how to link to workflow events, 48 
linked to a workflow, 17 
restrictions for editing names, 65 
showing/hiding, 15 
viewing from the specification tree, 14 

Spectra tab 
described, 75 

spectral data 
ratioing two spectral peaks, 122 
restrictions for viewing, 145 
setting directory path for archiving in RESULT Integration, 4 
viewing while running workflows in RESULT Integration, 75 

spectral files 
viewing with TQ Analyst software, 145 

spectral measurement methods 
calibrating, 126 
selecting regions, 125 
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spectral measurements 
specifying with the Workflow wizard, 30 
standards 
collecting for third-party methods, 128 
collecting in RESULT Integration, 108 
collecting with third-party method development software, 

129 
configuring in RESULT Integration, 96 
restrictions for archive location, 6 
restrictions for using Configure Standards, 97 
setting directory path for storing in RESULT Integration, 4 
specifying temperature/pressure values, 98 
using a sampling sequence when collecting, 102 

starting 
RESULT Integration software, 3 

status 
of workflows run in RESULT Integration software, 74 

Stepwise Multiple Linear Regression (SMLR), 120 

 
T 
temperature 

and running standards for method development, 98 
Test button, 11 
test collections, 152 
Test Workflow command, 71 
testing 

running an instrument check, 152 
testing a workflow 

executing events one at a time, 78 
in RESULT Integration software, 71 

text file 
requirements for creating a sampling sequence for use in a 

workflow, 60 
text results 

displayed during sequence data collection, 77 
text size 

setting for reports displayed in Run Time Test window, 73 
Text Size parameter, 73 
Text tab, described, 77 
third-party method development software 

building analytical methods, 128, 132 
collecting standards, 128, 129 
installing RESULT add-in options, 127 
location for storing method files, 128 
restrictions for digital signatures, 128, 131 

third-party methods 
linking to workflows in RESULT Integration, 134 

title bar 
in RESULT Integration software, 10 

toolbars 
in RESULT Integration software, 11 

Tools menu, 10, 96 
TQ Analyst method development software 

analysis types, 120 
building analytical methods, 113 
collecting standards for method development, 108 
configuring standards for method development, 96 
defining regions, 124 
entering a method file name, 115 
importing standards collected in RESULT, 115 
saving a new method, 126 
selecting measurement type, 120 
setting Pathlength Type, 122 
viewing spectra, 145 

TQ Analyst methods 
restrictions for locating, 6 

transferring workflows to RESULT Operation, 87 
tree 

on Details tab, 14 
on Workflow tab, 13 

troubleshooting 
for RESULT Integration software, 153 

 
U 
Undo command, 70 
undoing edits in workflows, 70 
Use Simulated Data parameter, 73 

restrictions, 73 
user names, 3 

restrictions for choosing, 81 
specifications for, 83 

 
V 
validation wheel information, viewing in Result Integration, 

152 
verification workflows 

creating, 88 
View Spectra command, 145 
View Spectra feature, 145 

restrictions for using, 145 

 
W 
windows 

RESULT Integration main, 9 
Run Time Test, 72 

Windows user names and passwords 
restrictions for choosing, 81 



 

170 RESULT Integration Software User Guide Thermo Scientific  

specifications for, 83 
Wizard button, 11 
workflow errors 

displayed in RESULT Integration software, 79 
workflow events, 13 

arranging, 65 
automatically linking specifications to, 44 
base names for, 42 
linking specifications to, 48 
restrictions for editing names, 65 
showing/hiding, 14 
viewing linked specifications, 17 

workflow files 
exporting, 91 

workflow groups, 13 
workflow navigation frame, 12 
workflow simulation spectra 

exporting, 93 
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